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1 Program Series PV*SOL 
The PV*SOL series supports the planner in the design of photovoltaic systems by dynamic simulation and 
yield calculation: 

 

• grid connected photovoltaic systems 

 

• grid connected photovoltaic systems 
using full feed-in or net metering 

• off-grid systems (Net Metering) 

 

• grid connected photovoltaic systems 
using full feed-in or net metering 

• off-grid systems (Net Metering) 

• 3D-visualization: 

o Module covering 

o Module mounting  

o Module wiring  

o with detailed shading analysis 

  

è See also: http://www.valentin.de/en/products/photovoltaics 

http://www.valentin.de/en/products/photovoltaics
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2 Software Management 

2.1 System Requirements 
  

PV*SOL Pro PV*SOL Expert 
Internet access     

Processor:  1,5 GHz Pentium PC 2,5 GHz Pentium PC 

Memory: 1024 MB 2048 MB 

Hard disk drive: 700 MB 

Monitor resolution: min. 1.024 x 768 Pixel 

Operating system: Windows XP Service Pack 3, Windows Vista, Windows 7 

Graphics: 
3D, DirectX– kompatibel, 128 E: 256 MB, OpenGL, Version 1.1 (needed for 

Photoplan) 

Software: DirectX, Version 9.0c; .net-Framework, Version 2.0 SP1 

  

To run the program, you must have read and write rights to the PV*SOL® program directory.   

PV*SOL®adopts the formats for currency, numbers, time and date set in the country settings of Windows' 
control panel.  
These formats also appear on print-outs. It is important for the operation of the program that separators 
for thousands and decimals are different. 

2.2 Activation of the Program 

2.2.1 Serial Number 
If you have purchased the program, you will have a serial number. 
This is made up of a combination of 38 digits and letters, which you will have to enter without any spaces 
in between, but including the special characters (hyphens). 

You will find the serial number either on the CD case or on the invoice. Alternatively, if you made your 
purchase online, you will have been notified by e-mail. 

2.2.2 Program ID 
The program ID is allocated specifically for your computer and is only valid for use on your computer. A 
valid serial number, issued on purchase of the program, is required to obtain an ID. 

The program ID is automatically provided as soon as you enter the serial number. 

It is not possible to enter the program ID yourself. 

You will need to let us know the program ID when registering, so that we can send you your key code. 

2.2.3 Requesting an Activation Key Code 
You can activate your program in two different ways. 
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Request a Key Code Online 

This method requires that your computer has internet access. 
Click on the Online button to open a form, where you can enter all the information required to receive a 
key code. The fields marked with an * must be completed. 
After you have completed the form, you can send it straight off – the recipient’s e-mail address is entered 
automatically for your convenience. After sending the e-mail, you will receive your key code, which will be 
sent to the e-mail address you have entered, in approximately 20 minutes. 

Request a Key Code by Telephone 

If you do not have a fax or e-mail, you can request the key code by phone. In this case, you will need to 
give us your program ID when you call. 

2.2.4 Enter the Activation Key Code 
Once you have completed registration, you will receive your key code within the following period: 

Approx. 20 minutes after online registration 

You can close the program in the meantime. When you go back into the program to continue registration, 
the entries you have made so far have been saved. 

Once you have received the key code following Registration, enter the key code into the key code input 
field. 

Click the OK button. You will receive a message, confirming that your program has been activated. 

You can now start working with the full program without having to start up again. 

We are pleased to support your work and wish you every success! 
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3 PV*SOL® Components 
The PV*SOL® components are: 

• PV modules 
• Inverters for grid connected and stand-alone systems 
• Batteries 
• MPP trackers 
• Load profiles for electrical load 
• Electrical appliances 
• Climate data for the system site 
• Tariffs for energy supplied to and drawn from the grid 
• Pollutant mix for electricity from the grid and energy savings. 
• Loans 

The individual components are defined via the corresponding menu or the speed buttons. 
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4 Quick Guide - Working on Projects 
In PV*SOL, a PV system is handled as project. 

Menus and dialogs are arranged from left to right and top to bottom to visualize the workflow: 

è Simulate a PV system as follows: 

 

1. Create a new project, using 
a) 2D = without the 3D Visualization, 
 
c) a Quick Design. 

 

 
b) 3D Visualization or 

 

2. Define Climate Data and otherConditions    

  3. PV system planning 

2D  

Define Technical Data of the system and 
the PV generator array  

 Define Losses 

 Define the Shade in 2D 

 Use the system Check 

 

3D  

Define systems using the 3D 
Visualization: 

Terrain,  
Buildings (Roofs), Slopes 

Module Coverage or  
Modul Mounting and  

Module Configuration 

  4. Calculations:    

 

Simulation   

 

Economic Efficiency Calculation   

  5. Results:   

 

Project Report    

  Economic Efficiency,   

 

Annual Energy Balance,   

 

Energy & Climate Data - Graphics   
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Variant Comparison    

  

24.01.2012 
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5 Operating Instructions & Workflow 

5.1 Operating Instructions 
The program is operated by using the menus, the symbols on the button bar and the mouse. The 
parameters on which the calculations are based are set in the appropriate dialog window (see Main 
Screen). 

PV*SOL® is a WINDOWS™ application, and the usual WINDOWS™ features and commands are 
incorporated as follows: 

The formats for numbers, date and currency are as per the settings within the WINDOWS system control 
panel. If you change the settings in the system control panel you will have to restart PV*SOL® in order to 
activate the changes within the program. 

All graphics within the program can be printed out. You are able to change the printer settings from 
within the program. 

The online Help facility giving information on all PV*SOL® dialog windows and menus is available via the 
function key F1 or the Help menu. In the Help menu you can search under various headings and key 
words, and, by clicking on the green colored text, you can go straight to the next link. Or you can simply 
scan through the individual help texts. 

The Variant Comparison table, the tables within the Graphics facility and the Appliances - Load Profile 
can be copied and pasted into other spreadsheet programs such as EXCEL. 

5.2 User Interface (Menu, Tool Bar, Dialogs) 
PV*SOL® is simple to use with the usual menu and tool bar.  

A menu command is deactivated when the lettering changes from black to grey. For example the 
command Calculations/Simulation is deactivated when valid simulation results are available. This 
command is reactivated only when the simulation results are no longer valid. 

All of the dialog windows required for inputting simulation parameters or to display results can be 
activated by clicking on the appropriate menu command, by using a combination of the ALT key plus the 
letter underlined in the menu command, or by clicking on the appropriate speed button symbol in the 
button bar on the left-hand side of the main screen. 

The dialog is closed by clicking on OK, Cancel or Close, by clicking on the WINDOWS button marked with 
an X in the top right-hand corner of the dialog, or by the key combination ALT+F4. 

The dialogs consist of input fields, selection fields , radio button , selection lists  and buttons. 

You can use either the mouse or the tab key to move between the fields within a dialog window. With the 
TAB key you move to the next field and with SHIFT+TAB back to the previous field. 

The various values are keyed into the input fields. When the arrow points over an input field it 
automatically changes to a cursor. With a single click of the left-hand mouse button in the input field you 
are ready to enter text with the keyboard. By double clicking on the input field the entire text within the 
field is marked and will be overwritten as soon as you start to type. 

The formats for numbering, date and currency are as per the settings within the WINDOWS system control 
panel. If you change the settings in the system control panel you will have to restart PV*SOL® in order to 
activate the changes within the program. 
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On quitting a dialog window with OK, the program checks whether valid formats have been used and at 
the same time tests if the entered values are within reasonable limits. 

In addition to the input fields, the program uses selection fields (check boxes). These are small square or 
circular fields that are activated or deactivated with a single click of the mouse. If the selection fields are 
grouped together, only one selection is possible. 

By clicking on the buttons in the dialog window you can open further dialogs. The buttons in the right or 
bottom button bar of a window (eg OK, Cancel, Copy, Close) control the window. 

Check boxes  allow selecting of multiple options, radio buttons  allow selecting an option. 

At the top of the main screen is a button bar with a number of speed buttons, each with a different icon. 
These icons represent the menu commands that you will use most frequently when working with the 
program. Clicking on the various speed buttons is the quickest and easiest way to get to the most 
important dialogs. 

Each speed button is labelled with its menu title. You just have to position the pointer over the button 
icon and a label appears with the title. 

5.2.1 Menu 
The menu is used to open the various dialogs which are used to enter the project parameters.  

If you want access the menu commands without using the mouse you can do so by pressing the Alt key 
and the corresponding underlined letter in the menu command. 

5.2.2 Speed Buttons Bar 
You can also quickly access the most important commands by clicking on the speed buttons in the button 
bar on the main screen. 

These buttons represent those menu commands that you will use most frequently when working with the 
program.  

Each speed button is labelled with its menu title. You just have to hover the mouse pointer over the 
button and a hint appears with the title. 

 

New Project  

 

Open... 

 

Save  

 

Technical Data (only systems without 3D visualization) 

 

3D visualization (only systems with 3D visualization) 

 

Climate Data Files  
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Tariffs  

 

Individual Appliances  

 

Appliances – Load Profile  

 

Shade (only systems without 3D visualization) 

 

Simulation  

 

Economic Efficiency Calculation... 

 

Annual Energy Balance 

 

Energy and Climate Data... 

 

Summary Project Report  

 

Variant Comparison... 

 

5.3 Load and Save File 
Projects, components, tariffs and appliance profiles are saved to file or loaded from this dialog. 

Each file type has its own format and a set file extension. These are: 

.prj for Projects 

.wbv for climate data 

.emm for the pollutant mix 

.tar for the from grid tariff 

.eta for the to grid tariff 

.slg for loads 

.mod for PV modules 

.wrn for inverters (grid connected) 

.wra for inverters (stand-alone) 
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.sch for shading 

.vbi for individual appliances 

.mpp for MPP trackers 

.acc for Batteries 

.cre for Loans 

From this dialog you can Select files from those available in the list. 

When you Open the dialog the directory that has been entered under the Options/Drives menu is 
displayed. If you want to select another directory as standard, you will have to do this in the Drives 
dialog. 

When a file from the file dialog is selected a description of the file contents appears in the field labelled 
”File Reference”. 

You are able to exit the dialog with OK only after you have selected or entered a name in the ”File Name” 
field. Click on the OK button to load the selected project. 

When you Save an existing file the project automatically checks if you want to go ahead and overwrite 
the file. 

The load file dialog for Modules and Inverters is different from the other standard dialogs. In addition to 
the file name, details on the contents of the files, ie manufacturer, type, output and voltage, are 
displayed. These details can be sorted by heading. Any new order selected will remain unchanged 
regardless from where the dialog is next opened. If you have already selected a type of module or 
inverter, this data record will be highlighted in blue. 

5.4 Simulation 
Starts simulation of the current project with the given parameters. The system is simulated at hourly 
intervals over a year. 

The basis for the calculations can be found in the program user manual. 

The simulation only takes a few seconds, although the exact time depends on the computer being used, 
the number of arrays in a system and the type of temperature model selected. 

After simulation you can select whether you want to run the Economic Efficiency Calculation, or view the 
Annual Energy Balance, the Summary Project Report, or the Graph of Results. 

You are also able to go back to the program’s main screen and continue work on your project using the 
menu bar or speed buttons. 

All results are now activated in the Results menu and can be viewed. As long as the project parameters 
remain unchanged you are not able to carry out the Calculations/Simulation command. 
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6 File Menu 
Here you will find all of the commands you will need for organising project files and you can exit the 
program via Exit. 

6.1 New Project 
This dialog window appears automatically when you start up PV*SOL the first time. From here you can 
start defining a new project. 

è Proceed as follows: 
1. Choose whether you want to simulate a grid connected or a stand-alone PV system (not available 

with PV*SOL®-N for grid connected systems only). 

2. Wählen Sie ein Einspeisekonzept: Volleinspeisung oder Überschusseinspeisung. 

3. Wählen Sie, ob Sie die Anlage als 2D, also ohne 3D-Visualisierung planen wollen, oder ob Sie die 3D-
Visualisierung nutzen wollen. 

4. Mit Hilfe der Kurzauslegung können Sie Ihre Anlage schnell und komfortabel planen. Die 
Kurzauslegung ist eine vollständige Simulation der Anlage, wobei sinnvolle Standardwerte 
verwendet werden. 
Falls die Kurzauslegung inaktiv (graue Schrift) ist, ist die entsprechende Standarddatei stndrd1.prx 
(netzparallel) bzw. stndrd2.prx (netzautark) im Installations-Unterverzeichnis /bin möglicherweise 
gelöscht worden.  

5. Bestätigen Sie Ihre Auswahl mit OK. 

Hatten Sie vorher ein Projekt geöffnet, so erscheint nun eine Abfrage, ob dieses Projekt gespeichert 
werden soll. 

Anschließend entspricht das PV*SOL-Hintergrundbild der von Ihnen gewählten Systemvariante. 

Quick Design 
If you answer ”Yes” to the question ”Do you want to start a new project with Quick Design?” the Quick 
Design screen will open. In this case the files stndrd1.prj (grid connected) or stndrd2.prj (stand-alone) 
will be used to provide standard values. 

If the corresponding field is grey and cannot be selected, it means that the standard file has possibly 
been deleted. If so, you can copy these files from the project folder 

(eg. c:\pvsol\projects\…) or rename an existing file from within Explorer. 

If you already have a project open prior to starting up a new project, a prompt will open asking you if you 
want to save the project that is open before the Quick Design screen opens. On leaving the New Project 
screen the main screen background changes according to the type of system you have selected. 

If you opt for starting a new project with Quick Design, the Quick Design dialog opens. From here you can 
simulate a solar system very quickly. 

The dialog windows vary according to the type of PV system – grid connected or stand-alone. 

6.2 Quick Design 
Quick Design allows a full system simulation to be carried out. 
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è Start the Quick Design by using File > New Project > Start new project with Quick Design > OK 
In addition to the entry parameters within the Quick Design dialog, all other quantities are provided by 
the program as standard values. 

After simulation you are given a Summary Report. The Summary Report can be printed out on one side of 
A4 paper. 

If you want to change the values entered in the Quick Design window and repeat the simulation, click on 
<< Back. Otherwise quit preview with OK and you can work on the project from the program and then run 
a new simulation. 

6.2.1 Quick Design – Stand-Alone Systems 
When designing a stand-alone PV system with Quick Design, after selecting the climate data file and 
entering values for the array orientation, you will have to define the consumption. 

Click on the Consumption button to define the 

Individual Appliances. From the Quick Design screen you are not able to define the consumption by load 
profile. 

PV*SOL® makes a design recommendation according to the selected criteria: low, medium or high solar 
coverage, or depending on a chosen month of the year. 

Click on the Design button and the required battery capacity and PV performance is shown. The desired 
system voltage needs to be selected, as does whether a back-up generator will be used. 

After selecting the types of battery and PV module, click on Sizing to view details on the performance and 
capacity reached. If the batteries, modules and system voltage selected do not match up a message 
appears asking you to check the components or adjust the voltage. 

The program selects a system with one PV array and direct battery connection. Direct current appliances 
are presumed to be in use. 

Click on OK to quit the dialog and the adjusted values will be saved into your current project. 

Click on the button Save as Default to save the values as a standard file. The next time you design a new 
project the Quick Design will open with these defaults. 

With Cancel the previous conditions are reinstated. Click on 

>> Simulation to start the simulation. 

6.2.2 Quick Design – Grid Connected Systems 
From the desired installed system power output and according to the selection of module and inverter 
types, the program calculates both a suggested number of modules and inverters, as well as 
recommending module connections. 

The program default settings provide a system consisting of one array that can have a number of 
inverters. All the energy produced is fed into the grid, so the appliances do not need to be defined. 

When you exit the dialog with OK the amended values are saved as your base project and the next time 
you start to design a new project the Quick Design window will open with these defaults. 

With Cancel the previous conditions are reinstated. Click on Continue to start the simulation. 
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6.3 Project Administration... 
In Project Administration you can enter the project name, the project number, the project designer and 
the location of the PV system. 

For easy project identification, these details will appear on any printouts that you make. 

From the main screen you can also enter a system variant reference. This appears as a file reference with 
the project file name. 

Whenever you exit a project with the command File/Save As…, the project administration details are 
saved with the project. 

With the command File/Save As... you can therefore save as many versions of a project as you wish, and 
they are easily recognisable by the comment you enter in the variant reference field. 

6.4 Open... 
File/Open... opens the Open File dialog, where all projects are listed – ie all files with the file ending 
*.prj. 

Select a file and the system variant reference appears in the file reference field. 

Double clicking on the file name, or clicking on the OK button, opens the selected project. 

If you are working on a project, and at the same time open another project, a message will appear asking 
if you want to save any changes made to the project you were originally working on, which will then close 
to enable you to work on the project you have opened. 

The other way to open existing projects is to go to the File menu. At the bottom of the menu is a list of the 
projects you have previously worked on, the first on the list being the project currently open. Just double 
click on any of the project file names to open the file. 

6.5 Save or Save As... 
File/Save saves the current project to the valid file path and name as previously saved. If a project file 
does not yet exist (ie you are saving a project for the first time), the Save As... dialog appears. 

File/Save As... saves the current project under a new name of your choice. The system variant reference 
is automatically selected as the file reference. 

This command is used when you want to design a new project or design a new version of a project. 

You should create a separate folder for each project, into which you can then save all the different 
versions of a project. 

6.6 Exit 
Go to File/Exit to close the program. 

If you have not yet saved the changes you have made to the current project, a message will appear asking 
if it should be saved. 

If you wish you can change the program settings, so that the last project you have worked on 
automatically opens the next time you use PV*SOL (instead of the Quick Design dialog), this is done via 
Options/Paths. 
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7 Conditions Menu 
Before a simulation can be carried out, the ecological and economic conditions have to be entered or 
confirmed using the menu commands listed to below. 

These details belong to the system, but are dependent on the location. 

With the exception of the To Grid Tariff this information is given by loading files from the database (either 
those delivered with the program, or any you have defined yourself in the Database). 

7.1 Climate Data Files 
With the Conditions > Climate data  menu command you open the module MeteoSyn, from which you can 
load the climate data file for the project location or the site closest to the project location. The files (eg 
London.wbv) contain values over a one year period for global radiation, external temperature and scaled 
wind speed in hourly format. 

Climate data can be viewed in graph format before and after simulation with the menu command Results 
> Energy and Climate Data.... Wind data is only evaluated when the “Dynamic Temperature Model” is 
selected under Options > Settings > Calculation Model. 

The irradiation onto the (tilted) PV surface, combining diffuse and direct radiation, is generated from 
global radiation. 

The ground reflection (albedo), entered in the Technical Data > Calculation Model > Losses dialog, is 
accounted for as a diffuse radiation gain. 

The radiation reflected off the module surface is accounted for as a reflection loss. After simulation you 
can view this data in diagram format under Results > Energy and Climate Data.... The details are divided 
into radiation onto the tilted PV array surface and radiation minus reflection and are shown in W/m². 

Reflection losses on the module surface lead to a decrease in the module’s efficiency. 

7.2 Pollutant Mix 
Pollutant Emissions results are loaded from the (Conditions/Pollutant Emissions/)Load file dialog. Here 
you can choose from a selection of files provided under Pollutant Mix in the database. 

If you want to define a new pollutant mix, you can do this via the Database/Pollutant Mix menu. Once 
saved you can then use the file for future projects. 
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8 System Menu 

è Precondition: Planning a 2D system 

8.1 Technical Data 
System > Technical Data  

The sheets used vary according to the system type (grid connected or stand-alone). 

3D: PV*SOL opens the 3D Visualization. There you define the terrain, buildings or slopes, cover 
roofs, mount modules and wire them by using 3D objects. The 3D Visualization has its own help. 

2D: The technical data for the system configuration are entered in this dialog, which is made up of 
a number of worksheets. 

è Proceed as follows: 
1. On the first page ”System”, you need to select whether the system uses an inverter system or 

multiple inverters. 

2. Enter the number of Arrays  for both types of system. 
You can enter up to a maximum of six arrays. 
A corresponding number of pages then appear on the bottom of the dialog, so that you can define the 
parameters for each sub-array separately.  
With a single array the page is labelled ”Array”. A number of sub-arrays are labelled: ”Array 1”, 
”Array 2” etc. 

About the buttons located on the right hand side of the dialog, refer to: 
3. Losses 

4. System Check 

5. Click on System Diagram for displaying a system sketch. This sketch also forms part of the Summary 
Report. 

6. If the System Check is positive, you can click on the Simulation button to start the Simulation. 

7. Close the dialog with OK. 

System Inverter 
System > Technical data > (Inverter concept) One system inverter > System inverter 

è Requirement: 
On the System page, the option System inverter is selected in the inverter concept area. 

è How to proceed: 
1. Select a suitable system inverter. 

The following data are displayed: 

MPP tracking range, 
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MPP voltages (STC) of the arrays, 

Inverter output, 

System output  

8.1.1 Technical Data – Stand-Alone  
(not available with PV*SOL®-N) 

8.1.1.1 Tab System   
With stand-alone systems you can select either MPP Tracking or Direct Battery Connection. 

If you opt for MPP tracking you will have to select whether you want to employ one MPP tracker for the 
entire system or one for each array. 

You will also have to select between Direct and Alternating Current Appliances. 

With the use of AC appliances you will need to define a stand-alone system inverter on the worksheet 
labelled ”Stand-Alone Inverter”. 

If you plan the use of a Back-up Generator a sheet is also provided for entering the parameters. 

8.1.1.2 Tab PV Array – Stand Alone 
The settings on the page labelled ”Array” or, if a number of sub-arrays are being used, on the pages 
labelled ”Array 1”, ”Array 2”, etc, vary depending on the selected system operation. 

Each PV array can be given a reference. 

Click on the PV Module button to open the Load File dialog and you can select from one of the database 
files provided. Tick the corresponding box and the module selected is used for all sub-arrays. 

If the module you want to use isn’t included in the database, you will have to go to Database/PV Module 
and then enter the details. Then you can go back to ”Technical Data” and select your module. 

When you exit the Load File dialog with OK the parameters entered into the database are taken into the 
current project. 

The Full Data Record for the module you have selected appears in an information window when you hold 
the cursor over the PV Module button. 

The installed output for the array and the system output (see PV output on the ”System” worksheet) is 
calculated from the Number of Modules. 

In selecting the Number of Modules in a String you will have to match the MPP tracking range or the 
battery voltage against the module’s MPP voltage. 

If you want to use an MPP tracker in your system design click on the MPP Tracker button to open the MPP 
Tracking Characteristics dialog. From here you can load or define an MPP tracker. 

In order to convert the irradiation onto the horizontal surface, as given in the climate data, into 
irradiation onto the mounted PV array surface the Inclination and Orientation have to be entered. 

You are also able to define single or double axis Tracking here. With Single Axis Tracking the program 
works with a set inclination while tracking the sun’s azimuth angle. With Dual Axis Tracking the array is 
positioned so that the sun’s radiation falls vertically onto the array at all times. When the array is in a Set 
Position (ie with no tracking) both the tilt angle and the orientation have to be entered. With Single Axis 
Tracking only the tile angle has to be entered. 
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The resulting annual irradiation per square metre, taking shade into account, is shown under Irradiation. 
Click on the Graph button to view or print details. 

Click on the Max. Irradiation Inclination button to find out the tilt angle required for maximum annual 
irradiation onto the array surface. With stand-alone systems the optimal inclination can deviate from the 
Max. Irradiation Inclination. The value appears on the button and can be accepted into the entry field. 
The current irradiation shown is dependent on this entry. 

The Type of Mount can be selected from Free-Standing, With Ventilation space and Without Ventilation 
space. 

The Direct Current Cabling to the charge controller is the cabling from the PV module string distributor 
to the charge controller. You can select from the standard Cable Cross Section measurements or enter 
your own measurement. 

The losses from each individual module cable running up to the string distributor can be accounted for in 
the ”Calculation Model and Losses” dialog. 

If a number of cables are run to the charge controller, you should add the cross section measurement for 
each cable together. 

8.1.1.3 Tab Stand-Alone Inverter 
If AC appliances are selected the system will need an inverter to convert the DC energy provided by the 
PV system into AC energy. 

Click on the Stand-Alone Inverter button to open the Load File dialog. If the inverter you want to use isn’t 
among the files listed you should go to Database/Inverter/Stand-Alone and enter the required 
parameters. 

Information on sizing is given in information fields (with a grey background). The inverter’s nominal AC 
output should correspond to both the appliances’ maximum power requirement and the battery’s 
nominal DC voltage. 

8.1.1.4 Tab Battery 
On the sheet labelled ”Battery” the type and number of batteries is defined. 

Click on the Battery button to load a battery file from the database. 

If the battery you want to use is not provided, go to the Database/Battery menu and enter the 
parameters. 

The Number and the Number in String need to match the inverter’s nominal DC voltage and the MPP 
tracker or the module voltage. 

If you plan to use a back-up generator you should enter 50% for the Charge Condition at Simulation 
Start, otherwise Preliminary Simulation should be marked to establish the charge condition (in this 
case the percentage figure is ignored). The previous year is simulated first, and the values from 31 
December are taken as the starting point for 1 January of the year being simulated. This avoids any shift 
in the simulation energy balance where the battery reaches a charge condition after simulation that 
strongly deviates from the start value. 

If the system uses a back-up generator the calculation of the correct start condition is not possible. 

8.1.1.5 Tab Charge Controller 
Because of the large number of different designs, there is no database unit for special charge controllers 
in PV*SOL®. 
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On the ”Charge Controller” sheet an entry is made for the battery’s Lower Discharge Threshold. 

For your information in regard to charge controller sizing, the short circuit current at 1000 W/m² and 50 C 
module temperature, and the appliances’ maximum electricity use are shown. 

8.1.1.6 Tab Back-up Generator 
If the use of a back-up generator has been specified on the ”System” sheet, a sheet labelled ”Back-up 
Generator” appears. 

The Nominal Output and the Minimum Power Output for the back-up generator need to be entered. 

The Fuel Consumption is required in order to produce a figure for pollutant emissions and for the 
Economic Efficiency Calculation. The Maximum Output - Appliances and the Total Battery Capacity are 
shown for information. 

A back-up generator that is required to always cover consumption during any shortfall of solar power 
must be able to deliver the maximum output required by the appliances (corrected by the battery charger 
efficiency rate). The generator modulates between minimum and maximum power output. With a single 
setting generator the minimum power output equals the nominal output. 

For the Battery Charger you need to enter the AC/DC conversion Efficiency, the Switch-on Threshold 
(this should not be less than the battery discharge threshold – see ”Battery Charger”), the Switch-off 
Threshold and the Switch-on Times for loading the battery. 

The back-up generator ensures a constant power supply to the appliances and that the lower battery 
discharge threshold is adhered to. If the back-up generator is switched on because the lower battery 
discharge threshold has been reached, it switches itself off only when the switch-off threshold is 
reached, provided that the timer is activated. 

Because covering the energy load requirement has priority, the battery is also charged if the generator, 
because of its minimum power output, delivers energy in excess of that required to cover the load. 

8.1.2 Technical Data – Grid Connected 
System > Technical Data > PV Array / Array I   

For grid connected systems you can choose between a system with a central System Inverter or a system 
with an inverter for each Arrayteilgenerator or with series or module inverters, ie with Multiple Inverters. 

The System Inverter is selected on its own sheet in this dialog. If you select a Multiple Inverter system 
you will need to enter the details for the inverters on each sub-array worksheet. 

On the other page/s the PV Array or sub-arrays are specified. 

In order to check the connection between the modules and inverters, and the influence of losses in the 
direct current cabling, you should click on the System Check button. 

Click on the System Diagram button to view the System Diagram, that will later form part of the 
Summary Report. Each PV array is represented as a PV and an inverter symbol. 

8.1.2.1 Tab PV Array – Grid Connected 
The PV array is specified on this worksheet. 

You are able to give each array a Reference. 

Click on the PV Module button to open the Load File dialog. From here you can select a file from the 
database. 
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If your preferred module isn’t listed, you will have to go to the Database menu and enter the details 
under PV Module. Then you’ll need to go back to the Technical Data dialog and select and load your 
module after clicking on the PV Module button. 

Exiting the Load File dialog with OK enters the parameters into the current project. 

On the array sheet/s you also enter the Number of Modules . You can also define the number of modules 
in the Roof Parameters dialog from the available Roof Area. 

The installed sub-array output and therefore the system output (see PV Output on the ”System” 
worksheet) is calculated from the number of modules. 

For the Type of Mount you’ll need to choose between ”Free-Standing”, ”With Ventilation” and ”Without 
Ventilation”. With Free-Standing modules, the required Minimum Distance between module strings is 
calculated in the Roof Parameters dialog, in order to minimise mutual shading. 

In order to convert the irradiation onto the horizontal surface, as given in the Climate data files, into 
irradiation onto the mounted PV surface, you have to enter the Tilt Angle and Orientation. 

You are also able to define single or double axis Tracking here. With Single Axis Tracking the program 
works with a set inclination while tracking the sun’s azimuth angle. With Dual Axis Tracking the array is 
positioned so that the sun’s radiation falls vertically onto the array at all times. When the array is in a Set 
Position (ie with no tracking) both the tilt angle and the orientation have to be entered. With Single Axis 
Tracking only the tilt angle has to be entered. 

The resulting annual irradiation per square metre, taking shade into account, is shown under Irradiation. 
Click on the Graph button to view or print details. 

Click on the Max. Irradiation Inclination button to find out the tilt angle required for maximum annual 
irradiation onto the array surface. With grid connected systems functioning under the full supply 
concept, the optimal inclination corresponds to the Max. Irradiation Inclination. The value appears on 
the button and can be accepted into the entry field. The respective irradiation shown is dependent on this 
entry. 

Click on the Inverter button to load one of the available database files from the Inverter database. 

If the Set Fixed Configuration when Selecting Inverter option is selected, only the inverters that match 
the number of modules in series are offered for selection in the load inverter file dialog. 

If the Set Fixed Configuration when Selecting Inverter option is not selected, all inverters are offered 
(in the load inverter file dialog) which match any configuration. After selecting the inverter, a suitable 
configuration can be selected under Configuration. 

The Load Inverter button is not visible if you have selected the System Inverter concept. In this case you 
load the inverter parameters from the System Inverter sheet. Likewise, the input field Number of 
Inverters only appears when you have selected the Multiple Inverters concept. 

If you hold the cursor over either the PV Module or Inverter buttons an information window appears 
giving the full data record details for the chosen PV module or inverter. 

Configuration per Inverter 

After selecting the inverter, you enter the Number of Modules in Series and, if required, the Number of 
Inverters onto the sub-array sheets. Under Configuration, all of the configurations that are technically 
possible are shown, taking into account the permitted values for current and voltage. 
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If the Set Fixed Configuration when Selecting Inverter option is selected, all of the mathematically 
possible module configurations per inverter are shown. 

If a multi-string inverter with multiple independent MPP trackers is selected, it is possible to enter the 
configuration for each MPP tracker separately in the Define Multi-String Configuration dialog. 

For the DC Cabling to the inverter, the program calculates the wiring from the PV module string 
distributor up to the point of entry into the inverter. 

Standard Cable Cross Section measurements can be selected or you can enter your own measurement. 

You can account for general losses from the cabling running from the individual modules to the string 
distributor in the Technical Data/Calculation Model/Losses dialog. 

8.1.2.2 Tab System > Inverter Concept 
System > Technical Data  

The number of modules per inverter is determined by the number of modules divided by the number of 
inverters. 

Because the program only allows a symmetrical connection, the number of modules per inverter must be 
equal for all the series in an array. 

An automatic system check takes place on quitting the dialog with OK. The following error dialog could 
appear: 

The number of modules must be a multiple of the number of inverters. 

In setting the number of inverters you should ensure that the installed power capacity for the modules 
and inverters match. 

8.1.3 Roof Parameters 
System (2d) > Technical Data > Array > Roof Parameters 

The Roof View window is divided into the following sections:  

• Toolbar on top 
• Tree view on the left 
• Roof visualisation on the right 
• Input field below 
• Messages at the very bottom 

8.1.3.1 Roof View - Toolbar 

 
The toolbar contains the buttons listed below. The current cursor position is also displayed under 
Coordinates, which allows you to find the position of an object point, for example. 
The area of the toolbar to the right shows the distance of a selected barred area point or PV area point 
from the outer borders of the roof area.  

    Create a New 2D Object 
The Create a New 2D Object button opens the  New 2D Object dialog. Here you can define new roof areas, 
barred areas or PV areas.  
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    Copy 2D Object 
Once you have selected a barred area or a PV area you can copy this to the clipboard by clicking the Copy 
2D Object button (or pressing CTRL+C). You can then paste the copied barred area or PV area into your 
roof area by right-clicking and selecting the Paste command (or pressing CTRL+V).  

    Delete 2D Object 
Click the Delete 2D Object button (or press the Delete key) to delete selected barred areas, PV areas, 
modules or module formations.  

    Delete All PV Areas 
Attention! Clicking the Delete All PV Areas button deletes all the PV areas.  

    Delete All 2D Objects (except roof) 
Clicking this button deletes all the 2D objects except for the roof area.  

    Enlarge view 
This button enlarges the view of the roof area.  

    Reduce view 
This button reduces the view of the roof area.  

    Zoom - Select Best View 
Clicking this button sets the optimum zoom factor.  

8.1.3.2 Tree view 
System (2d) > Technical Data > Array i > Roof Parameters 

The tree view gives you an overview of the 2D 
objects that are used in your PV system. 
 
Left-click on an element in the tree view to select 
the 2D object.  

Right-click on a 2D object in the tree view to open a 
context menu with all the available commands for 
the selected 2D object. 
 
 

 

8.1.3.3 Roof Mounting 
System > Technical Data > (Generator Output) Determine Output from Roof Area > Roof Parameters  > 
Cover Automatically (context menu on roof visualization) 

The Roof Mounting visualization shows your current roof project including the PV areas and barred areas. 

è Requirements: 
1. In the dialog Technical Data in the area Generator Output select the option Determine Output from 

Roof Area.  
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2. Click the button Roof Parameters. The dialog Roof View opens.  

è Proceed as follows: 
1. The roof view is displayed. Define barred areas as new 2D objects and borders. 

You can drag and drop PV areas and barred areas to move them. 

If a 2D object is selected, its corner points are shown and can be edited in the input field. 

The compass rose at the top right of the image is available for projects with mounted PV modules. 

 
It shows the direction that the roof faces. 

2. Click on the roof area and open 
the context menu via right-
mouse click.  

3. Select Cover automatically or 
use Edit PV Area. 
The following keyboard 
shortcuts are available for 
editing the module formations:  

CTRL + left mouse key: 
        Multiple selection 

SHIFT + left mouse key:        Row 
selection 

ALT + left mouse key: 
          Column selection 

4. Zoom in and out in the roof visualization by rolling the (middle) mouse wheel. 

      

8.1.3.4 Messages 
The messages area shows you the following information: 

Type of installation 

PV generator power 

Number of modules 

 
Messages about any conflicts in the roof coverage are also displayed here.    
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No conflicts exist. 

   

A PV area overlaps with a barred area. 

   

At least one module in a PV area is located outside the roof area. 

   

The modules of various PV areas overlap. 

 

8.1.3.5 Input Field 
The appearance of the input field varies depending on the type of object that is selected in the tree view.  

When Roof View is selected, an overview of the workflow appears: 

1. Enter roof dimensions 

2. Define barred areas 

3. Create new PV area 

4. Cover this PV area with modules. 

5. Position PV Area   

  
By selecting Current Roof you can rename the roof boundaries that appear in the roof visualisation.  

 
 
By selecting the roof object (default: New Roof) you can edit the coordinates of individual points of the 
selected object. 

You can use the    buttons to add or remove points from the selected roof object.  

Click the   button to open the Edge Distances window.  
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If you are planning a mounted PV system, you can also enter the roof orientation and the roof angle.  

 
By selecting a barred area object (default: Barred Area 1) you can edit the coordinates of individual points 
of the selected object. 
Under Enter position you can enter the position of the entire selected object.  

 
By selecting a PV area object (default: New PV Area) you can edit the coordinates of individual points of 
the selected object. 

Click the   button to open the Module Coverage dialog.  

 

8.1.3.6 Border Distances 
System (2D) > Technical Data > Array i > 
(Generator Output) Roof Parameter > Context 

Menu (right-click on roof)   Border 
Distances 

In the Border Distances window you 
can specify barred areas of a certain 
width for the borders of your roof. 
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è Proceed as follows:  
1. In the tree view select the roof area.  

2. and in the input field click the Border Distances button .  

3. If you want to define equal border distances for all the boundaries of your roof, then select the option 
For all Borders and enter a number in the edit field on the right-hand side of the window. 

Otherwise enter individual border distances for each border of the roof in the table on the left side. 

4. Close the window with OK. 

  

8.1.3.7 New 2D Object 

System (2D) > Technical Data > Array i > (Generator Output) Roof Parameter >   New 2D Object 

The New 2D Object dialog lets you define new 2D objects for your project.  

è Proceed as follows: 

1. Click the button . The dialog "New 2D Object" opens. 

2. First, select the  object type in the drop-down menu at the top left: Roof Area, Barred Area or 

PV Area.  

3. Then enter a reference name for your new 2D object. 

4. Depending on the selected object type, different standard forms and options are available for 
defining the new 2D object:  

New Roof Area 

System (2D) > Technical Data > Array i > (Generator Output) Roof Parameter >   New 2D Object >   Roof Area 

è Proceed as follows: 
1. Enter a reference name for your new 2D object. 

2. Open the window Border Distances  where you can specify barred areas for the borders of your 
roof.  

3. Select on of the geometric standard forms: 

Rectangle 

 

Trapezium 
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Triangle 

 

Enter the form sizes. 

For simple roof areas without barred areas and border distances:  
Tick the Cover roof to maximum box to give the new roof area a PV area the same size as your roof.  
PV modules will then be added automatically when you click on OK.  

If needed, repeat the same procedure for Barred areas  and the   PV area. 

4. Close the dialog using OK. 
The roof is visualized accordingly. 

New Barred Area 

System (2D) > Technical Data > Array i > (Generator Output) Roof Parameter >   New 2D Object > Barred Area 

è Requirement: 

You have defined the roof area. 

è Proceed as follows: 
1. Enter a reference name for your new barred area. 

2. Select one of the geometric standard forms:  

Rectangle 

 

Trapezium 

 

Triangle 

 

Circle   

Enter the form sizes. 

Repeat this for  PV areas accordingly. 

Close the dialog using OK. 
The roof is visualized accordingly.  
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New PV Area 

System (2D) > Technical Data > Array i > (Generator Output) Roof Parameter >   New 2D Object > PV 
Area 

è Requirement: 

1. You have defined the   roof area. 

2. You have defined necessary   barred areas. 

è Proceed as follows: 
1. Enter a reference name for your new PV area. 

2. Select one of the geometric standard forms:  

Rectangle 

 

Trapezium 

 

Triangle 

 

3. Enter the form sizes. 

4. Or, if needed select the option  "Fit to roof area"  

 
The new PV area takes the shape and dimensions of the existing roof area.   

5. Or, select the option  "Based on number of modules":  
The size of the new PV area is determined for a specified module formation. 
- Enter the number of rows and columns in the planned module formation. 
- The resulting power of the module formation is displayed. 

6.  Tick the Cover roof afterwards box to add PV modules to the new array area automatically after 
you click on OK.  

7. Close the dialog using OK. 
The roof is visualized accordingly.   
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8.1.3.8 Module Coverage 
To open the Module Coverage dialog: In the tree view, select a PV area and click in the input field on the 

Edit coverage button . Alternatively you can right-click on a PV area in the roof visualisation or open a 
pop-up menu in the tree view and click on Edit coverage. 

The Module Coverage dialog lets you specify the column distances and the row distances for the PV 
modules. The minimum distance for both values is 0.05 m = 5 cm. 

Under Installation type you can specify the module orientation (horizontal or vertical). 

The Calculate Optimum Row Distance command is only available for mounted PV systems (Installation 
type: Free-Standing). By finding the optimum row distance you can minimise mutual shading caused by 
mounted module rows. 

 
8.1.3.8.1 Calculate the Optimum Row Distance 

 
For mounted PV systems (Installation type: Free-Standing) you can calculate the optimum row distance. 
This minimises mutual shading between rows of mounted modules.  

The suggested clearance is a function of module inclination β, position of sun  γ on 21.12. at 12.00 p.m. 
and the mounting height h of the module.  
To open the Row Distance dialog, open the Module Coverage dialog and click on 

 . 
 

8.1.4 Workflow 
Example for a PV system with ventilation.  
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Specify the size of your roof area. To do this, select the roof area by left-clicking on the roof area in the 
roof visualisation or select your roof area in the tree view (default: New Roof). You can now specify the 
size and shape of your roof in the input field.  

First of all, delete all 2D objects by clicking the Delete All 2D Objects (except roof) button  . 

Alternatively you can delete particular 2D objects by clicking the  button, for example to obtain a 
barred area that you require.  

Specify the barred areas for the borders of your roof area. To do this, select the roof area by clicking on 
the roof area in the roof visualisation or select your roof area in the tree view (default: New Roof). Now in 

the input field click on the    button and define the required barred areas in the Edge Distances 
dialog. 

Now create a new barred area (e.g. skylights and chimney). Your roof might look something like this: 
 

  

To define a PV area that is matched to the roof area, click the Create a New 2D Object button  to open 
the New 2D Object dialog.  

Select PV Area in the drop-down menu at the top left.  

Select the Fit to roof area option for the new PV area.  

Now tick the Cover roof afterwards checkbox.  

Click OK and PV modules will automatically be added to the roof area. Now your roof might look 
something like this: 



8 System Menu Manual PV*SOL Expert 5.5 

Dr. Valentin EnergieSoftware GmbH  36 / 98 

 

  

Now you can specify the installation type (horizontal or vertical) and the distances between the PV 
modules in the Module Coverage dialog. 
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8.1.5 Photo Plan 
System > Technical Data > PV Array / Array i > Photo Plan 

Using Photo Plan, you can create a photorealistic plan of your roof areas. With just a few entries on the 
geometry of the roof, it is possible to gain an impression of the future look of the roof areas. You require 
only a photo of the roof. 

In addition, Velux® skylights and Braas® roof tiles can be included and displayed.  

Before   After 
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8.1.6 Orientation 
System > Technical Data > PV Array / Array i > Orientation  

The Inclination (Tilt Angle) represents the angle between the horizontal and the collector surface. It is 0° 
when the module is laying flat on the ground and 90° when standing upright. 

The Orientation (Azimuth) represents the angle of deviation of the PV surface from the south in the 
northern hemisphere and from the north in the southern hemisphere. It is 0° when the surface is facing 
towards the sun’s highest point (zenith). 

PV*SOL recognizes from the climate data, which contains the degree of latitude, whether the system is 
located in the northern or southern hemisphere. 

The azimuth is positive when facing west and negative when facing east. An orientation due west 
corresponds to a value of +90° and an orientation due east is -90°. 

From the inclination and orientation the radiation processor calculates the irradiation onto the tilted 
surface. Click on the Graph button to view the annual irradiation fluctuations [kWh/m²] and the annual 
radiation duration curve [W/m²]. 
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8.1.7 Installation Type 
System > Technical Data > PV Array / Array i > Installation Type  

The installation type influences the heating of the PV modules. 

With a ”Free-Standing” mount the entire module surface (front and back) exchanges radiation with its 
environment. 

For a roof-top mount ”With Ventilation” only the upper module surface is available for radiation 
exchange, and for roof-top or façade integration ”Without Ventilation” this is reduced further. With roof 
or building integration the output is reduced further by a lack of convection. 

High module temperature leads to a drop in module efficiency. Yields for PV systems with free-standing 
mounting are therefore higher than those for systems with ventilation space which in turn have higher 
yields than systems without ventilation space. 

8.1.8 Losses 
System > Technical Data > Losses 

The array’s power output (DC side) is, along with the STC efficiency and the calculated output, 
determined by the part load operation, the output’s temperature dependency (see output coefficient in 
the PV Module dialog) and the additional losses. 

Losses occur during real system operation: 

• due to deviation from the standard spectrum AM 1.5, 
• due to mismatch or lesser yield due to deviation from the manufacturer’s data 
• in the diodes, and 
• due to pollution. 
• Deviation from Standard Spectrum AM 1.5: 

Spectral mismatch changes the module’s characteristic curve, which is measured against a standard 
spectrum. In Central Europe a correction factor of an annual average of 2% can be allowed for. The 
correction factor should be entered in the field provided. 

Mismatch or Lesser Yield Due to Deviation from Manufacturer’s Data: 

Despite equal irradiation and temperature, different MPPs (mismatching) can occur because of 
production tolerances, or because the modules do not reach their full power as stated by the 
manufacturer (lesser yield). These kind of power losses can reach 1-5%. (This does not mean the 
”mismatch effect” that occurs if differently aligned modules, ie a number of sub-arrays, are connected to 
a single system inverter. These losses are defined during simulation.) 

Diodes: Losses caused by a drop in voltage by the modules’ blocking diodes can usually be ignored. 

Pollution: Over a certain tilt angle (approx. 20%) losses caused by pollution can be ignored. 

Ground Reflection (albedo) is evaluated in the radiation processor. PV array irradiation is increased by 
the reflection of radiation on the ground or in the surrounding area. With a ground covering of snow the 
albedo is 80%, under normal conditions the albedo is 20%. 

  

Allowing for Manufacturer Tolerances in Pre-Graded Sub-Arrays 

If the module output (power rating) deviates from that specified by the manufacturer, you are able to take 
this into account here. This, for example, makes sense when you have pre-sorted the modules according 
to power output. 



8 System Menu Manual PV*SOL Expert 5.5 

Dr. Valentin EnergieSoftware GmbH  40 / 98 

From the System Height above ground level it is possible to determine the scalar wind at system height 
for the dynamic Temperature Model. The wind in the climate data is measured at a height of 10 meters. 

8.1.9 System Diagram 
System > Technical Data >  System Diagram 

The System Diagram is a colored sketch of the system. This will later form part of the Summary Report. 

System components such as arrays, inverters, batteries, and also the consumption as well as the grid 
concept are illustrated as symbols. Important details, such as the number and type of modules or 
inverters, are also shown. 

The System Diagram is a sketch. It cannot be edited and does not represent a full technical drawing of 
the system. 

8.2 Shade 

è Precondition: Planning a 2D system 

è Proceed as follows: 
1. Enter of the shade parameters in the program is in two stages. You are able to define the horizon and 

middle-distance objects (see Shade from Individual Object). 

The Azimuth angle is the deviation from south, as in the ”Technical Data” dialog. Due east is entered as -
90° and due west as +90°. 

Middle-distance objects means objects that need to be taken into account in the calculation, because the 
PV array is fully shaded by these objects at certain times of the day. 

The entries for shading from the horizon and middle-distance objects reduces the irradiation onto the 
array surface, and a correction factor enables the program to simulate the shade moving over the array. 

The program allows a sketch of the horizon parameters to be made using the mouse. Values are given at 
the bottom of the window, as is the following message: 

To start the sketch click on New Sketch or click on the horizon line with the left mouse button. 

New Sketch 
Adding a vertical to the existing horizon line can be difficult. This is better done by entering an individual 
object. Click on Object List to open the Shade from Individual Object dialog. 

You can make a new sketch of the horizon at any time. 

Another method is to enter the horizon parameters into the Table. 

If you have a system with a number of arrays not only is each of these given its own page in the Shade 
dialog, but there is also a button labelled All Arrays. 

Click on All Arrays and the parameters for the horizon currently on screen are adopted for all of the sub-
arrays. The individual objects are, however, not adopted. 

Save the shade parameters to file or load an existing file in order to use horizon or individual object 
parameters again. 
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8.2.1 Coordinates Table 
Another method of entering the horizon is to enter the values into the horizon coordinates table. The 
start and end points are already entered, as are any coordinates you have drawn with the mouse in the 
sketch. 

Any new points are added to the table in consecutive order. Click on New Point to define a point and on 
Add Point to add the values to both the table and the sketch. 

Any points in the table can be deleted by first clicking on them (so that they are highlighted in blue) and 
then clicking on the Delete Point button. 

8.2.2 New Sketch 
Click on the New Sketch button and the cursor is represented as a pencil symbol. As soon as you move 
the cursor over the sketch area a line is drawn between the starting point and the cursor position. The 
actual cursor position is shown at the top of the dialog. 

The position of the line is accepted by clicking on the desired end position within the sketch area. The 
horizon sketch is always drawn from left to right. If you move left of a starting point the cursor changes 
into a warning hand and a line is no longer drawn. 

If you want to interrupt the sketch click with the right mouse button. This message also appears at the 
bottom of the dialog: 

Click with right mouse button to end sketch. 

If you want to rework any lines you have drawn, you can only do this after the current sketch is complete, 
as per the message given at the bottom of the sketch: 

To rework the horizon click on the horizon line with the left mouse button. 

8.2.3 Shade Caused by Individual Objects 
In addition to shade from the horizon (see also section on Shade) the program also allows definition of 
individual objects that shade an array. 

The objects already defined are found in the List of All Objects. From the left hand side of the window 
you can select the object whose value you wish to see or change. If no object has been defined, the list is 
empty. 

Next to the object reference in the top right of the window, a corresponding illustration of the type of 
object, tree or house, appears when a selection is made. 

If you want to define a new object click on New House or New Tree, according to the type of object 
causing the shade. A new object (eg with the reference No. 1) is created and the standard values appear 
on the right of the window. 

The difference between a tree and house is the extent to which the object allows light through. On 
selecting a new tree the Seasonal Shade button is activated and you are able to enter a percentage 
figure for each month of the year. In summer the shade from the leaves of a tree will be 90%, in winter 
this figure will be more like 40%. 

Objects can be deleted from the list by highlighting the object in the list and then clicking on the Delete 
Object button. 

The specifications from which objects in the vicinity can be defined are: height, width, distance and 
azimuth. 
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The point of measurement for setting these dimensions is the middle point of the array surface, facing 
south. Therefore an azimuth of 0° means that the object is positioned to the south, independent from the 
PV array’s actual azimuth. 

The elevation angle is defined from the specification of the height and distance. Width and azimuth 
represent the object’s angle coordinates. 

  

The calculated dimensions (fields with grey background) are first calculated on leaving the object, and 
the values are updated when the values are loaded again. 

8.3 Appliances Menu 
There are two ways of setting the electricity requirement. 

If you are able to give a figure for the total annual energy consumption, you should enter this value in the 
load profile dialog. If not, you can enter values for a range of individual electrical appliances. 

If you use both of the above methods, the program calculates the total requirement. If, for example, you 
have entered values in the load profile dialog, the energy requirement is shown when you open the 
individual appliances dialog, and is then included in the calculation of the total energy requirement. 

When designing a stand-alone system you will need to select either AC or DC appliances in the 
System/Technical Data menu. 

8.3.1 Individual Appliances - Consumption 
In this dialog you are able to define the energy requirement for up to 20 individual appliances. 

Click on the New button to define parameters for a new appliance. The following actions apply to the 
individual appliance you have selected. Click on the name (not the symbol) of the appliance to select it 
(this will then be marked blue). 

Click on the Load button to load preset parameters from the database for the appliance selected. Click on 
the Delete button to delete the appliance selected. 

Click on the button with the appliance’s symbol to open the Individual Appliance dialog. 

8.3.2 Kilowatt-Hour Price 
The price per kilowatt-hour for each tariff period - high tariff (HT), low tariff (LT) and any special tariff (ST) 
- is defined in this dialog. In order to be able to define the tariffs for special periods, these have to be 
entered under Tariff Time Periods. 

Inflation: 

The rates that need to be entered into the table are basic prices that produce the kilowatt-hour rate when 
multiplied by the Inflation. With the Inflation the grid utility company takes the current energy price and 
eg. wage increases into account. Normally, only the basic price level is used in the low voltage range, so 
that the Inflation is 1 in this case. 

Summer/Winter Different: 
Different kilowatt-hour rates can be entered for summer and winter times. In this case the prices are not 
valid for the whole year’s energy consumption, but for summer and winter periods. If at the same time 
Different Pricing Bands for Each Tariff Period is selected you can separate out the kilowatt-hour rates 
for summer and winter periods into high and low tariffs. 
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Staggered Consumption Regulation: 
If this selection is made the valid kilowatt-hour price is given as follows: 

With a total annual consumption during HT periods of 600,000 kWh, for example, the price band starting 
from a consumption level larger than 500,000 kWh is valid, for the total energy produced during the HT 
period HT energy the basic price of 0.35 €/kWh is valid. 

Consumption Zone Regulation: 
On making this selection the text of the first column changes in order to make the prices given clearer. 
”Consumption larger than” becomes ”Each further kWh from”. The valid kilowatt-hour rate is given as 
follows: 

With a total annual consumption during HT periods of 600,000 kWh, for example, a basic price of 0.36 
€/kWh for the first 250,000 kWh is valid, for the second 250,000 kWh the basic price of 0.35 €/kWh is 
valid and for the final 100,000 kWh a basic price of 0.33 €/kWh is valid. 

The total HT kilowatt-hour rate is therefore calculated as follows: 

Total HT kilowatt-hour rate : (250.000 kWh * 0.36 €/kWh + 250.000 kWh * 0.35 €/kWh + 100.000 kWh * 
0.33 €/kWh) * Inflation 

Different Pricing Bands for Each Tariff Time Period: 
On making this selection the kilowatt-hour rate for each tariff period is given its own worksheet. In this 
case the valid pricing band is no longer given as the total annual consumption, but as the total 
consumption in the time period that is valid for each worksheet. If, for example, Summer/Winter 
Different is not selected, then the valid kilowatt-hour rate for the winter HT is only given in the total 
consumption for summer and winter HT. 

See also: From Grid Tariff 

8.3.3 Load Utilisation Period Discount by Table 
Instead of a linear climbing load utilisation period discount (see Discounts), it is also possible to account 
for price bands in a table. The discount table values can be entered in the Load Utilisation Period 
Discount dialog. Here it is also the case that a Load Utilisation Period Discount is first observed when the 
minimum load utilisation period is reached. 

8.3.4 Individual Appliances: Short-Time Use Appliance 
A short-time use appliance is a user-dependent appliance that is generally switched on for less than an 
hour each time it is used, eg iron, coffee maker. 

Stand-by: an entry here is only made for appliances with this facility where stand-by is always active 
when the appliance is not in operation. 

Operating Times – Each Time Appliance Used: entry of either the period of use or the electricity 
requirement. 

Hourly Use: entry in the bar showing the hours of the day. If the tick is removed it is possible to enter 
hourly use separately for each day of the week. 

8.3.5 Power Measurement 
The basic specifications for power measurement are entered in this dialog. Further specifications can be 
made depending on the type of power measurement selected. The following power measurement 
categories are available: 
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• No Power Measurement 
• 96 Hour Measurement 
• Standard Calculation (¼ hour power measurement) 
• Light/Heavy Load Maximums 
• No Power Measurement 

If the tariff for energy supply from the grid suffices without power measurement, then you should select 
”No Power Measurement”. 

96 Hour Measurement 
With the 96 hour tariff the electricity consumption in kWh within 96 consecutive hours is added together 
in a consecutive time window. These hourly values are called power values (Pow. Val.). The highest power 
value within the time period measured is used for the calculation of power payment. The power payment 
is the sum of the highest power value multiplied by the valid load price for annual electricity 
consumption according to the given pricing band. 

During 96 hour measurement with time zone regulation, the recording of the power values during low 
tariff is suspended without changing the consecutive timing for the 96 hour measurement periods. In this 
case Measurement Only During HT Periods must be selected in the Load Price dialog 

Standard Calculation (¼ hour power measurement) 
This calculates the power from the average value of the highest monthly power output figures. The 
number of months that are used to calculate the maximum annual power output is entered in the Load 
Price dialog. 

Light/Heavy Load Maximums 
¼ hour power measurement, with the time period used for providing the billing load being limited to the 
so called heavy load periods. These heavy load periods are entered in the Heavy Load Periods dialog. 
Further definition of the heavy load peak is described under Standard Calculation. 

The lowest monthly light load is entered separately. 

Output peaks during low output periods are only considered if the monthly low output peak reaches a 
level above the given annual peak power output at peak load times. The monthly differences of these 
values are sorted according to size and an average value is calculated. The resulting difference is only 
partly used in the calculation, the factor is entered in the Load Price dialog. The number of months used 
for producing a figure for the light load peak is also entered in the Load Price dialog. The sum of the 
heavy load maximum and the allowed for light load share gives a figure for the calculated power. 

Set Load Price: 
The electricity payment is made up of two parts: a set price and a price dependent on consumption. The 
set load price must always be paid separately from the price for grid power actually used. 

Hourly Peaks in the Defined Load Plus: 
(only for Standard Calculation and Heavy/Light Load Maximums) 

Depending on the grid utility company, monthly power outputs are measured in ¼ or ½ hour averages. 
The highest output during the year is multiplied with the given specific load price, in order to give a figure 
for the annual load price that will have to be paid. In the program the highest monthly output figure is the 
highest occurring average hourly output in each month (to account for the time stages). This leads to 
lower output peaks because the ¼ hour variations are levelled out. In order to correct this the highest 
monthly outputs for calculating the highest annual output are multiplied by the ¼ hour peaks in the 
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defined loads plus. Depending on the type of appliance, the size of the area supplied, and any measured 
loads to hand, a percentage figure between 0% and 50% must be entered here. For typical housing 
estates with an annual consumption of more than 100,000 kWh, an annual consumption of 5-10% can be 
used for the calculation. 

Minimum Power Output: 
(only for Standard Calculation and Heavy/Light Load Maximums) 

This measure is only used in the calculation if the maximum output is less than this value. 

Wholesale Provision: 
(only for Standard Calculation and Heavy/Light Load Maximums) 

Instead of a set load price, a price for wholesale provision can be requested. This is paid if the hours of 
full use (HFU) do not reach the set threshold value. The wholesale provision price (WPP) is calculated as 
follows: 

WPP = price [€/kW] * max. power output 

 * (1 HFU/hours of minimum use) 

Max. power output: the maximum power output calculated by the program, or possibly the minimum 
output. 

HFU: 
Hours of full use = total annual kWh output/maximum output 

8.3.6 Individual Appliance: Light 
An appliance is defined as a light when it is switched on depending on the amount of daylight. 

Stand-by: an entry here is only made for appliances with this facility where stand-by is always active 
when the appliance is not in operation. 

Operating Times: 

All days the same: if the tick is removed, it is possible to enter different operating times for all the days of 
the week. 

Clock: the hours of operation are set by clicking on the fields (green field = in operation, white field = not 
in operation). The appliance can only operate within the defined operating hours. 

No Other Restriction: the operating times are as defined by the clock. 

Full Darkness: the operating hours are only valid if, at the same time, global radiation equals zero. . 

Dusk: the operating hours are only valid if, at the same time, global radiation is less than 20 W/m². 

Dull Weather: the operating hours are only valid if, at the same time, global radiation is less than 
50 W/m². 

8.3.7 Individual Appliances: User-Dependent Appliance 
A user-dependent appliance is used regularly and at certain times, eg TV, computer. 

Stand-by: an entry here is only made for appliances with this facility where stand-by is always active 
when the appliance is not in operation. 

Operating Times: 
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All days the same: if the tick is removed, it is possible to enter different operating times for all the days of 
the week. 

Clock: the hours of operation are set by clicking on the fields (green field = in operation, white field = not 
in operation). 

No Other Restriction: the operating times are as defined by the clock. 

Nights Only: the operating hours are only valid if, at the same time, global radiation equals zero. . 

Days Only: the operating hours are only valid if, at the same time, global radiation is greater than zero. 

8.3.8 Individual Appliances: User-Independent Appliance 
A user-independent appliance is not normally switched on and off by the user, but runs automatically for 
long periods of time – eg refrigerator, deep-freeze. 

Stand-by: an entry is not possible in the case of an appliance in constant use. 

Annual Energy Requirement: the annual energy requirement should be given for general operation over 
the whole year. 

Operating Times: the appliance can either be defined as being in constant use or by the intervals it 
remains switched on. 

Appliance in Constant Use: the appliance is generally switched on the whole time. 

Switch on Every…: sets the switching-on interval. 

8.3.9 Discounts 

General Discount: 
Here you can enter rebates/discounts that are guaranteed regardless of consumption, eg a discount for 
electricity drawn at the 30 kV voltage level. 

Load Utilisation Period Discount: 
(only for Standard Calculation and Heavy/Light Load Maximums in the Power Measurement dialog) 

The load utilisation period is the relationship of total annual energy drawn from the grid to the billing 
load, and is a measurement of the regularity of energy use. With some tariffs or special deals the 
electricity company gives the customer a discount from a point over a certain minimum load utilisation 
period. This discount is, as a rule, included in the total kilowatt-hour and load tariff payments. In the case 
that the discount is only observed for HT energy and the load price, it is referred to as the HT utilisation 
period rebate. 

Minimum Load Utilisation Period: 
A discount is first included in the calculation when the load utilisation period is above this figure. If the 
usage is below this figure, an additional charge does not have to be made in compensation. 

Load Utilisation Period Discount Valid for: 
Here you can select the payment categories for which the load utilisation period discount are valid for. 

Load Utilisation Period Discount by Formula: 
If this option is selected the load utilisation period discount is calculated using the following formula: 

if the load utilisation period – minimum load utilisation period > 0 load utilisation period discount = 
Factor X * (load utilisation period – minimum load utilisation period) 
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Load Utilisation Period: 
The relationship of total annual energy drawn from the grid to the billing load. 

If the calculated load utilisation period discount exceeds the maximum load utilisation period discount, 
this figure (ie the greater) is observed. 

Load Utilisation Period Discount by Table: 
Instead of a linear climbing load utilisation period discount, it is also possible to account for price bands 
in a table. The discount table values can be entered in the Load Utilisation Period Discount dialog. Here it 
is also the case that a load utilisation period discount is first observed when the minimum load 
utilisation period is reached. 

8.3.10 Heavy Load Periods 
The heavy load periods for the grid are defined in this dialog. 

Heavy Load Periods - Summer/Winter Different: 
If you click on this button you are able to enter all the heavy load periods separately for summer and 
winter. 

Heavy Load Periods – From… To: 
If the heavy load periods for summer and winter are different, this is where you define the beginning and 
end of winter time for the heavy load periods. Entry of heavy load periods is made in date format dd.mm. 
. 

New Heavy Load Periods Valid From: 
With the assistance of this field you are able to define the days in the week that heavy load periods are 
valid on. The days of the week are given in the first column, so that it is clear for which day the time 
entered is valid. 

Heavy Load Periods: 
You are able to enter up to 5 time periods (from hour to hour) for each day of the week. Entry is made in 
time format. 

8.3.11 Discounts/Supplements 
You can enter Discounts and Supplements from the electricity utility separately on the two pages 
provided. 

8.3.12 Electrical Appliances by Load Profile 
The electrical energy requirement for an appliance load is defined in the Electrical Appliances dialog. 
For ease of identification this can be given a Name. 

The Annual Energy Consumption for the appliance load is entered directly (in kWh). 

The hourly pattern of consumption is set via a consumption profile. The consumption on Saturdays and 
Sundays is entered as a percentage of the weekday usage. 

The required consumption profile can only be loaded from this dialog, not defined. Click on the 
Consumption Profile button to open the Load File dialog. 

If you want to define your own load profile, you have to go to the Appliances Load Profile database and 
save your profile from there. 
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Click on the Graphics button to display the time pattern of energy consumption based on the current 
entries and the consumption profile that has been defined. 

Click on the Holiday Periods button to open the Holiday Periods dialog. 

8.3.13 Tariffs 
This is where you set the tariffs for power supply to and from the grid (Conditions/Tariffs menu). 

Clicking on the To Grid Tariff button opens the To Grid Tariff dialog. From here you can define or load a 
tariff. 

Clicking on the From Grid Tariff button opens the Load File dialog and you can then choose from the 
tariffs provided in the database under From Grid Tariff. To help you choose the correct tariff level, a 
description of the tariff is given in the file reference field. 

In the (Electricity) Tariffs dialog, under Supply Concept, you need to select whether all PV energy 
produced should be fed into the grid (select Full Supply), or whether the energy requirement of the 
appliances connected to the system should first be covered (select Own Use). 

Even if you select the full supply concept, you are still able to define the appliance load and thereby 
monitor the overall costs of electricity used by the appliances connected to the system. 

8.3.14 Tariff Time Periods 
The high tariff periods (HT) and any special tariff periods (ST) are defined here. These tariff periods are 
valid for the supply of energy both to and from the grid utility. 

Winter Time: From… To: 
Entry of the tariff period for winter is made in dd.mm format. . 

Different Tariff Periods – Summer/Winter: 
Select to enter separate tariff periods for summer and winter. 

Define Special Tariff Periods: 
Select to create a new worksheet for the entry of a special tariff period in addition to high and low tariff 
periods. Separate kilowatt-hour rates can be entered for these times in the Kilowatt-Hour Price dialog. 
When a high tariff period is also defined as a special tariff period, this period is valid as a special tariff 
period. 

New HT Periods Valid From: 
With the assistance of these selection fields you can define which days in the week different tariff 
periods are valid on. The first column shows on which days of the week the times entered are valid. 

High Tariff Periods: 
You can enter up to 5 time periods (from ... to ... hours) per day. Enter these values in time format. 

8.3.15 Holiday Periods dialog 
Up to three holiday periods can be entered. The entry should be made in date format (dd.mm). 

If no holiday periods are to be defined, you will have to enter the same date in the fields labelled From… 
To. 

In addition to the holiday periods, the Energy Requirement during the holidays is defined in this window 
as a percentage of workday consumption. 
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8.3.16 Load Profile 

 

By clicking on the New Load Profile button you can define an additional 
load. You can define up to four separate electrical load profiles. 

 

By clicking on the button with the symbol representing the electrical 
appliances (light bulb), the window for defining the load profile for the 
Electrical Appliances is activated. 

  

The name given to the appliance load and the total annual electrical energy consumption entered is 
shown next to the electrical appliance symbol. 

You will need for enter a From Grid Tariff for your electrical appliances. This is done in the 
Conditions/Tariffs menu. 

The total annual electrical energy requirement for all of the appliances you have defined is shown in the 
bar at the base of the dialog. The hourly maximum value is displayed after simulation. 

8.3.17 Supplements 

Supplements: 
Here you can enter HT or LT energy and the load price, with any supplements, as a percentage figure. 

Set Costs [€/a]: (eg accounting fees) 
Set annual costs are entered here, such as measurement and billing costs, that must be paid regardless 
of the consumption. 
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9 Calculations Menu 
If the system parameters have been defined and climate data has been selected, the program is able to 
carry out a simulation of energy yields. After that an economic efficiency calculation is possible, once you 
have entered tariffs for energy supply to and from the grid. 

The Simulation command cannot be accessed (the lettering is grey not black) when valid results are 
available (ie a simulation has already been carried out and the parameters remain unchanged). The 
Economic Efficiency Calculation command cannot be accessed when there are no valid simulation 
results available. 

9.1 Quick Design 
Quick Design allows a full system simulation to be carried out. 

è Start the Quick Design by using File > New Project > Start new project with Quick Design > OK 
In addition to the entry parameters within the Quick Design dialog, all other quantities are provided by 
the program as standard values. 

After simulation you are given a Summary Report. The Summary Report can be printed out on one side of 
A4 paper. 

If you want to change the values entered in the Quick Design window and repeat the simulation, click on 
<< Back. Otherwise quit preview with OK and you can work on the project from the program and then run 
a new simulation. 

9.2 Simulation 
Starts simulation of the current project with the given parameters. The system is simulated at hourly 
intervals over a year. 

The basis for the calculations can be found in the program user manual. 

The simulation only takes a few seconds, although the exact time depends on the computer being used, 
the number of arrays in a system and the type of temperature model selected. 

After simulation you can select whether you want to run the Economic Efficiency Calculation, or view the 
Annual Energy Balance, the Summary Project Report, or the Graph of Results. 

You are also able to go back to the program’s main screen and continue work on your project using the 
menu bar or speed buttons. 

All results are now activated in the Results menu and can be viewed. As long as the project parameters 
remain unchanged you are not able to carry out the Calculations/Simulation command. 

9.3 Economic Efficiency Calculation 
After simulation it is possible to carry out an Economic Efficiency Calculation.  

The Economic Efficiency Calculation follows the net present value method. 

The entry dialogs and the dimensions calculated are different for stand-alone and grid connected 
systems. 
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9.3.1 Economic Efficiency Calculation – Technical Input 
This dialog shows the basic parameters in PV*SOL which are relevant for the Economic Efficiency 
Calculation. 

PV Peak Output: 
The output of the system defined in PV*SOL under Standard Test Conditions. 

(STC: 25°C module temperature, sunlight spectrum of AM 1.5 and 1000 W/m² irradiation.) 

Electricity Supplied to Grid in First Year: 
This specifies the amount of electricity fed into the grid in a whole year. The month that the system 
started operation and degradation are not allowed for here. 

Electricity Costs Saved in First Year: 
This specifies the cost saving made on electricity drawn from the grid in a whole year. The month that the 
system started operation and degradation are not allowed for here. 

System Operation Start Date: 
This date is required for the proportionate allowance for lodgements and disbursements made in the first 
year. Investments, One-off Payments and Subsidies arise independently of the date in the year that the 
system starts operation. 

If the Start Date is in the second half of the year, only 50% Depreciation can be accounted for. 

Costs that are settled annually are calculated proportionately in the year in which the system started 
operation. 

Use Tariff to Calculate Income from PV Generation:  
For the Payment Received for Grid Supply the following rule applies: the amount shown is paid, for 
example, for 20 full years plus the months in the first year of operation. 

To Grid Tariff: 
By clicking on the Load File button a To Grid Tariff can be loaded or amended. 

Set Feed-In Payment:  
In the field Feed-In Payment for the First (X) Years, you can directly enter the resulting Income from PV 
Generation. 

Degradation  
Degradation is the reduction in module power caused by ageing. You have the choice of entering a 
Constant Degradation for 20 years, or you can define a different degradation for each year. 

Click on Degradiation to define the different levels of power loss for each year. 

9.3.2 Define Output Losses 
Calculation > Economic Efficiency Calculation > Technical Input > System output reduction due to age (degradation) 

Here you are able to define power loss in the PV modules caused by ageing. 

Enter the annual Output Losses as a percentage of the nominal output (power rating). In the Remaining 
Output column you will then see the resulting output as a percentage of the nominal output. The Output 
Losses defined first take effect at the end of a period, ie losses for the first year first come into effect in 
the second year, etc. After 10 years, the power output of the PV module remains constant. 
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If you wish to allow for deviation in the first year of the PV modules’ actual output from the nominal 
output, then enter this figure in the field labelled Deviation of Module Output from Nominal Output. 

9.3.3 Payback Period 
The period required to get to the point when the net present value of the investment first becomes 
positive. 

9.3.4 Net Present Value 
The Net Present Value is calculated from the: 

• Cash Value of all Annual Costs 
• Cash Value of all Annual Lodgements and Savings 
• Cash Value of Loan Payments 
• Cash Value of Tax Payments 
• One-off Payments 
• Subsidies 
• Self-Financing 

9.3.5 Economic Efficiency Calculation - Other Proceeds/Savings 
Here you can define any Other Annual Proceeds/Savings. 

Click on Add Position to add a new position to the list. 

To delete a position, first highlight the row by clicking on the appropriate cell in the first column and then 
click on Delete Position. 

The Inflation indicates the average percentage change of a payment in comparison with the previous 
year. 

9.3.6 Electricity Production Costs 
The Electricity Production Costs are the annual costs divided by the amount of electricity produced. 

The annual costs result from the: 

• Cash value of annual costs, 
• One-off Payments, 
• Loan Payments 
• Self-Financing 

multiplied by the Annuity Factor. 

9.3.7 Results Overview 
The following payment sequences are available in the Results Overview: 

• Total Investments 
• Total Operating Costs 
• Total Consumption Costs 
• Total Other Costs 
• Total One-off Payments 
• Total Disbursements/Savings 
• Total Subsidies 

Total Loan Payments 
Interest plus Repayments 
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Total Loan Interest 

Payment Received for Grid Supply 

Electricity Savings 

Self-Financing 
Total of Investments, One-off Payments less Subsidies 

Depreciation 

Result before Tax 
Total of: 
-Operating Costs, 
-Consumption Costs, 
-Other Costs, 
-Subsidies, 
-One-off Payments 
-Disbursements/Savings 
-Payment Received for Grid Supply 
-Electricity Savings 
-Depreciation 
-Loan Interest 

Tax Rebate 
Is calculated using the Marginal Tax Rate from the Result before Tax. 

Result after Tax 
Result before Tax plus Tax Rebate 

Cash Flow after Tax 
Total of: 
-Operating Costs, 
-Consumption Costs, 
-Other Costs, 
-Disbursements/Savings 
-Payment Received for Grid Supply 
-Electricity Savings 
-Loan Payments 
-Self-Financing 
-Tax Rebate 

Outstanding Loan Payments 
Payments are listed here which at the time require interest and repayments to be paid. 

Cash Balance (Accrued Cash Flow) 
Total Cash Flow after Tax 

Cash Balance less Outstanding Loans 

9.3.8 Economic Efficiency Calculation – Stand-Alone Systems 
First of all you need to enter the parameters required for the Economic Efficiency Calculation. This is done 
on four different sheets:  

•  Parameters 
•  PV Costs, Breakdown of Costs 
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•  Back-up Generator 
•  Financing 

Once all the parameters have been entered you can view and print the results by clicking on the 
Economic Efficiency Calculation button. 

9.3.8.1 Economic Efficiency Calculation – Stand-Alone Systems: Basic Parameters 
The following parameters are entered on this page: 

Capital Interest Rate 
This is the interest on capital borrowed from the bank for the PV investment or the interest that could be 
charged on the capital used. 

Price Increase Rates 
Changes to running costs and fuel costs (if a back-up generator is to be used) are important for 
calculating the cash value of the system. Increase rates for electronics, batteries and the back-up 
generator can also be included. 

Lifespan 
The period given by the manufacturer as the expected lifespan of the system. For PV systems this is 
usually set between 10 and 25 years. The program allows various lifespan periods to be entered for 
electronics, batteries and the back-up generator. 

9.3.8.2 Economic Efficiency Calculation – Stand-Alone Systems: PV Costs, Breakdown of Costs 
The following parameters for the PV system costs are entered on this page: 

Investment 
The investment can be given as an absolute amount or as a specific cost in €/kWp. 

Subsidy 
The subsidy can be given as an absolute sum, as a percentage of the investment or as a specific subsidy 
in €/kWp. 

Running costs 
The running costs can be given as an annual amount or as a percentage of the investment in percent per 
annum. 

Component Cost Allocation 
On this sheet the PV system costs can be split between its components: PV modules, electronics and 
batteries. 

9.3.8.3 Economic Efficiency Calculation – Stand-Alone Systems: Back-up Generator 
If a back-up generator is to be used, the costs are entered on a separate page. 

Investment 
The investment can be given as an absolute amount or as a specific cost in €/kW. 

Running Costs 
The running costs can be given as an annual amount or as a percentage of the investment in percent per 
annum. 
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Specific Fuel Costs 
Fuel costs are entered as an amount per litre. The annual fuel requirement is shown after simulation. 

 Economic Efficiency Calculation – Stand-Alone Systems 

9.3.8.4 Economic Efficiency Calculation – Stand-Alone Systems: Financing 
Details on financing are entered on this page. 

A loan can be loaded from the Database via the selection list or the folder button. 

Loan capital 
The amount of credit in € that is arranged. 

Term 
The time period that has been arranged for paying back the loan. 

You also have to enter the Annual Instalment or the Loan Interest. In either case the other input field 
cannot be accessed and is calculated by the program. 

Annual Instalment 
The set annual instalment which pays back the loan and interest within the credit term. 

Loan Interest 
The amount of interest that has to be paid on a loan. 

If the loan interest rate is lower than the capital interest rate taking out a loan works like a subsidy, if the 
rate is higher the total costs increase. When interest rates are equal there is no difference. 

9.3.9 Economic Efficiency Calculation – Grid Connected Systems 

9.3.9.1 Overview of Economic Efficiency Calculation for Grid Connected Systems 
You are able to move through the Economic Efficiency Calculation in two ways. With the Continue and 
Back buttons at the bottom of the window, you can go to the next or the previous page. With the left-
hand Navigation Bar you can jump straight to the required page. 

The Economic Efficiency Calculation consists of the following pages: 

•  Calculation Basis 
•  Basic Parameters 
•  Balance of Costs 
•  Investment Costs 
•  One-off Payments (+-) 
•  Operating Costs 
•  Other Costs 
•  Consumption Costs 
•  Subsidies 
•  Loans 
•  Tax 
•  Results 
•  Graphics 
•  Tables 
•  Report 



9 Calculations Menu Manual PV*SOL Expert 5.5 

Dr. Valentin EnergieSoftware GmbH  56 / 98 

Every window contains a Help button (in the top right corner) which gives help in respect of the required 
entry parameters. 

9.3.9.2 Economic Efficiency Calculation – Technical Input 
This dialog shows the basic parameters in PV*SOL which are relevant for the Economic Efficiency 
Calculation. 

PV Peak Output: 
The output of the system defined in PV*SOL under Standard Test Conditions. 

(STC: 25°C module temperature, sunlight spectrum of AM 1.5 and 1000 W/m² irradiation.) 

Electricity Supplied to Grid in First Year: 
This specifies the amount of electricity fed into the grid in a whole year. The month that the system 
started operation and degradation are not allowed for here. 

Electricity Costs Saved in First Year: 
This specifies the cost saving made on electricity drawn from the grid in a whole year. The month that the 
system started operation and degradation are not allowed for here. 

System Operation Start Date: 
This date is required for the proportionate allowance for lodgements and disbursements made in the first 
year. Investments, One-off Payments and Subsidies arise independently of the date in the year that the 
system starts operation. 

If the Start Date is in the second half of the year, only 50% Depreciation can be accounted for. 

Costs that are settled annually are calculated proportionately in the year in which the system started 
operation. 

Use Tariff to Calculate Income from PV Generation:  
For the Payment Received for Grid Supply the following rule applies: the amount shown is paid, for 
example, for 20 full years plus the months in the first year of operation. 

To Grid Tariff: 
By clicking on the Load File button a To Grid Tariff can be loaded or amended. 

Set Feed-In Payment:  
In the field Feed-In Payment for the First (X) Years, you can directly enter the resulting Income from PV 
Generation. 

Degradation  
Degradation is the reduction in module power caused by ageing. You have the choice of entering a 
Constant Degradation for 20 years, or you can define a different degradation for each year. 

Click on Degradiation to define the different levels of power loss for each year. 

9.3.9.3 Economic Efficiency Calculation – Basic Parameters 

Assessment Period: 
Only complete years, not including the year in which the system starts operation, should be entered for 
the Assessment Period. 
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According to German standard VDI 6025, the Assessment Period is the time period of planning base for 
the calculation of economic efficiency (planning horizon). 

The Assessment Period should be based on the investment with the shortest Service Life. 

If the Service Life of an investment is less than the Assessment Period, the investment will have to be 
repurchased. 

If the Service Life of an investment is greater than the Assessment Period, the investment will have a 
residual value at the end of the Assessment Period, which is included in the capital value calculation. 

Interest on Capital: 
The Interest on Capital can be entered as the Rotating Internal Rate of Return. The Rotating Internal Rate 
of Return is the average yield from fixed interest bonds. The German Federal Bank determines this from 
the average yields on outstanding debt securities. The Rotating Internal Rate of Return is therefore a 
measure of the interest level on the bond market. 

Value Added Sales Tax 
This entry field does not influence the calculation, but is there to make clear that all amounts should be 
entered either with or without sales tax. As a rule, all amounts should be entered as net sums. However, 
if you enter a gross amount, you should make sure that all entries are gross. 

9.3.9.4 Economic Efficiency Calculation – Income and Expenditure 
On the Balance of Costs page you are able to enter all payments divided into cost groups. 

The program recognizes the following cost groups: 

• Tax deductable investments 
• Non-tax deductible outgoing cost of system setup parts and labor 
• Incoming subsidies 
• Outgoing annual operating costs 
• Consumption costs 
• Outgoing other annual costs 
• Incoming other income/savings 

If you want to enter a number of positions within a cost group, select the Detailed Entry for the cost 
group. This will automatically take you to the corresponding page, where you can enter as many 
positions for the cost group as you wish. 

If you have selected the Detailed Entry on the Balance of Costs page, the field text is grey and the total of 
payments for the cost group is shown. 

For each cost group you can choose to make absolute or specific entries, but this option is not available if 
the Detailed Entry selection has been made. 

9.3.9.5 Economic Efficiency Calculation – Investment Costs 
Click on Add Position to add a new position to the list. 

To delete a position, first highlight the row by clicking on the appropriate cell in the first column and then 
click on Delete Position. 

The Inflation indicates the average percentage change of a payment in comparison with the previous 
year. 

The Service Life is the time period measured in years of the economic use of an investment object. 
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If the Service Life of an investment is less than the Assessment Period, the investment will have to be 
repurchased. 

The price of repurchase is based on the Price Change Factor given. 

If the Service Life of an investment is greater than the Assessment Period, the investment will have a 
residual value at the end of the Assessment Period, which is included in the net present value 
calculation. 

9.3.9.6 Economic Efficiency Calculation – Non-tax deductible Outgoing cost of system setup parts 
and labor 

On this page you can define Non-tax deductible Outgoing cost of system setup parts and labor, 
arising at the time the system starts operation, and Savings. 

Click on Add Position to add a new position to the list. 

To delete a position, first highlight the row by clicking on the appropriate cell in the first column and then 
click on Delete Position. 

One-off Payments are (unlike investments) costs which cannot be written-off against tax. They are taxed 
directly. 

9.3.9.7 Economic Efficiency Calculation – Other Costs 
On this page you are able to define any Other Annual Costs. . 

Click on Add Position to add a new position to the list. 

To delete a position, first highlight the row by clicking on the appropriate cell in the first column and then 
click on Delete Position. 

The Inflation indicates the average percentage change of a payment in comparison with the previous 
year. 

9.3.9.8 Economic Efficiency Calculation – Operating Costs 
Click on Add Position to add a new position to the list. 

To delete a position, first highlight the row by clicking on the appropriate cell in the first column and then 
click on Delete Position. 

The Inflation indicates the average percentage change of a payment in comparison with the previous 
year. 

9.3.9.9 Economic Efficiency Calculation – Consumption Costs 
Here you can define the Consumption Costs. 

Click on Add Position to add a new position to the list. 

To delete a position, first highlight the row by clicking on the appropriate cell in the first column and then 
click on Delete Position. 

The Inflation indicates the average percentage change of a payment in comparison with the previous 
year. 

9.3.9.10 Economic Efficiency Calculation - Subsidies 
On this page you can define one-off Subsidies received at the start of system operation. 

Click on Add Position to add a new position to the list. 
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To delete a position, first highlight the row by clicking on the appropriate cell in the first column and then 
click on Delete Position. 

Subsidies reduce the costs. They do not influence tax depreciation, but are taxed directly. 

9.3.9.11 Economic Efficiency Calculation – Loans 

Number of Loans 
Here you can enter the number of loans that you want to define. You can account for 0-3 loans. 

Reference 
Here you can give the loan a name, which will then appear in the Project Report. 

Loan Capital 
The amount of credit, with the calculation based on interest and repayment. The loan amount can be 
entered as an absolute figure in euros or as a percentage of the investment volume. Investment Volume 
is understood here as the investments plus one-off payments less subsidies. 

Payment Instalment as a percentage of the loan capital (Discount) 

This value specifies which percentage amount of the loan capital entered is actually paid. 

The loan amount paid is based on the loan capital multiplied by the disbursement rate. 

The Total Disbursements for all loans should not be greater than the Investment Volume defined above. 

You will also need to define whether the loan is an Instalment Loan or an Annuity Loan. 

Instalment Loan 
With this kind of loan, repayments are made in equal instalments. The amount of interest to be paid is 
recalculated after each instalment from the remaining amount of debt. The total repayment amount is 
calculated from repayments which remain constant and interest on an amount which reduces over the 
period. 

Annuity Loan 
With this kind of loan, repayments are made in equal instalments over the repayment period. The loan 
repayment amount as a percentage of the instalment increases with the number of instalments, while the 
interest percentage sinks correspondingly. 

Period 
The loan-repayment period. 

Loan Interest 
Nominal Interest Rate to be paid on the remaining debt. 

Repayment-Free Initial Years 
During this period no repayments, but only interest payments are made. In the remaining time up to the 
end of the period, the loan capital is repaid in instalments. 

Repayment Interval 
Interest and instalments are paid at these intervals. 

. 
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9.3.9.12 Economic Efficiency Calculation - Tax 
In order for tax payments to be included in the Economic Efficiency Calculation, you will need to select 
the Allow for Tax field. 

It is usually the case that with a profitable investment the inclusion of tax payments has a negative 
impact on the results. The results only improve with changing tax rates. A change in tax rate is possible, 
for example, if the investor retires after 10 years. If, at the time that the system starts to enter the profit 
zone, the investor is making losses on other investments, the tax rate could also be set at zero. 

Marginal Tax Rate for Income/Corporation Tax: 
This is the tax rate that needs to be paid for each additional taxable Euro. The amount should also appear 
in your tax assessment. 

If Allow for Change in Marginal Tax Rate is selected, the New Tax Rate given in Change of Tax Rate comes 
into the calculation. 

Depreciation Period: 
The period over which the investment can be written-off against tax. The usual period for photovoltaic 
systems is 20 years. 

Depreciation Type: 

Linear (straight line): 
Annual depreciation is calculated from the investment amount divided by the depreciation period. 

Degressive (reducing balance): 
Annual depreciation is not constant, but is calculated as follows: 

Investments that have not yet been depreciated are multiplied with the rate of depreciation. This leads to 
a year by year decrease in the annual depreciation. If the annual depreciation sinks below the value that 
is obtained through linear depreciation, the residual value is calculated as linear depreciation for the 
remaining period. 

9.3.9.13 Economic Efficiency Calculation - Results 
The basic Results of the Economic Efficiency Calculation are shown here. 

Exactly which Results are shown depends on the amount of self-financing being made towards the total 
investment. 

The Results shown here also appear in the Project Report. 

The system’s Net Present Value and the Electricity Production Costs are always calculated. 

The Payback Period and the Net Yield are related to the amount of self-financing used. Therefore these 
Results can only be calculated when the amount of self-financing is greater than zero. If the investment is 
partly financed by borrowed capital, the program calculates a Minimum System Operating Period, 
following which the amount of self-financing used and the loan payments have been recouped. 

If the Minimum System Operating Period is greater than the Payback Period, the Minimum System 
Operating Period is given. 

Exactly which graph is shown depends on whether the Payback Period or the Minimum System Operating 
Period is given. 

If the Payback Period is given, the Cash Balance (Accrued Cash Flow) graph is shown. 
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If the Minimum System Operating Period is given, the Cash Balance less Outstanding Loans graph is 
shown. 

9.3.9.14 Economic Efficiency Calculation - Graphics 
You are able to select whether and how interest is calculated on the Payment Sequences: 

Discount Payments (Cash Value) 
The reference point for this method of observation is the time before the start of the Assessment Period. 
The discounted interest on all payments is calculated at this point. The results of the Economic Efficiency 
Calculation form the basis of this type of assessment (Capital Value, Payback Period, Internal Rate of 
Return, Electricity Production Costs). 

Interest on Payments 
The reference point for this method of observation is the end of the Assessment Period. It can be 
interpreted as the balance of account. 
For a payment, eg of €1000 in the first year, interest is calculated at n-times capital interest up to the end 
of the Assessment Period, for a payment in the second year, at n-1-times. 

No Interest on Payments  
A payment of, for example, €1000 in the first year has the same value as a payment of €1000 after 20 
years. This gives a clear view, but is not suitable for making economic decisions. 

You can display 2 curves via the selection fields. If you only want to see one curve, you should select <no 
curves> in the 2nd Curve field. 

Print Graphic 
The graphic displayed can be viewed via the Print Preview before printing. The page is fixed to print in 
horizontal format. 

Copy Graphic 
The graphic displayed can also be copied to the clipboard, for example if you want to add it to your 
project report in Microsoft Word. You would have to export the project report into Microsoft Word first – 
this is done via the Print Preview. 

For information on compiling the results, see also Results Overview 

9.3.9.15 Economic Efficiency Calculation - Tables 
You are able to select whether and how interest is calculated on the Payment Sequences: 

Value of Payment Sequences (Cash Value) 
The reference point for this method of observation is the time before the start of the Assessment Period. 
The discounted interest on all payments is calculated at this point. The results of the Economic Efficiency 
Calculation form the basis of this type of assessment (Net Present Value, Payback Period, Net Yield, 
Electricity Production Costs). 

Pay Interest on Payment Sequences 
The reference point for this method of observation is the end of the Assessment Period. It can be 
interpreted as the balance of account. 
For a payment, eg of €1000 in the first year, interest is calculated at n-times capital interest up to the end 
of the Assessment Period, for a payment in the second year, at n-1-times. 
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Do Not Pay Interest on Payment Sequences 
A payment of, for example, €1000 in the first year has the same value as a payment of €1000 after 20 
years. This gives a clear view, but is not suitable for making economic decisions. 

In the table’s second column, the total payments over the Assessment Period are shown. No totals are 
shown for the Payment Sequences that have already been accrued. In respect of the Investment Costs, 
the Residual Value of the investment at the end of the Assessment Period is given in the final column. 

Copy Table 
The table displayed can also be copied to the clipboard, for example if you want to calculate your own 
results or to create your own graphics from within a spreadsheet program. 

For information on compiling the results, see also Results Overview 

9.3.9.16 Economic Efficiency Calculation - Report 
Here you are able to select the items that will appear in the Project Report. 

The Results Overview gives details of the actual results, and this should always be printed out. 

In addition, you can print a Detailed List of Income/Expenditure. This shows all the entries specified 
under the headings Balance of Costs and Loans. 

You can also select which graphics you would like to appear in the report. 

Click on Print Preview to take a look at the pages included in the report. From here you can print the 
report and create a PDF file. You can also export to Microsoft Word or other word processing programs 
that accept documents in RTF format. You are then able to change the report layout, for example. 
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10 Results Menu 
With PV*SOL® you have a number of alternatives for evaluating the simulation results. The results are not 
saved, as the results files would be too large and you can simply and quickly re-run a simulation 
whenever you wish. 

There is, however, a roundabout way of saving the results if required. This is done from within the 
Graphics facility in the Table menu command. 

Most menu commands are only activated (ie the lettering is black not grey) after simulation. However, 
you are able to view the data loaded from the Climate data files, the parameters entered under Technical 
Data in the Detailed Project Report and the Variant Comparison at any time. 

10.1 Annual Energy Balance 
The quickest way to view the most important results after simulation is to go to the Annual Energy 
Balance. 

The annual results for energies and various evaluation dimensions are given in table format. 

The output values vary according to the type of system. 

If you have defined a PV system with a number of sub-arrays the values for each array are each given on a 
separate sheet. 

You will find more details on output values under the heading Definitions 

If you want to print the results go to Project Report/Summary. 

If you want to view the values over a period of time go to Energy and Climate Data. 

10.2 Energy & Climate Data - Graphics 

Printing Graphics 
The usual WINDOWS print dialog appears in which you can select the settings and printer desired. 

Graphics Screen 

Legend 
This field contains a description for each data record being displayed. 

If energies are illustrated, the sum of the energy in the selected period is shown next to the name of the 
data record. 

Power output, temperatures, wind speed and evaluation quantities (energy coverage, performance ratios 
and efficiencies) are displayed as mean values for the period. 

The legend can be selected and repositioned. 

Title 
By double clicking on the title frame a dialog window opens in which you can give the graph or chart a 
new title. When you close this window the new title appears in the title frame. The title can dragged and 
dropped with the mouse to any position within the graphics window. 
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Co-ordinates Field 
At the base of the graphics window a field displays the actual co-ordinates indicated by the mouse 
pointer when it is located within the diagram. The date and time, as well as the x-value for the position of 
the mouse pointer are shown. 

Selecting and Amending the Data and Axes 
The individual data records displayed in the graph or chart and the x and y-axes can be selected by a 
single click of the left mouse button. The selection is shown by points along the lines in a line graph and 
on the bars in a bar chart. Click just below the lines for a line graph and the x axis, just under the top of 
one of the bars for a bar chart and to the left of the line for the y-axis. 

By double clicking on the x or y-axes the dialog window Formatting the X-Axis or Formatting the Y-Axis 
appears. By clicking with the right mouse button on either the axes or the graph a pop-up menu appears 
with the corresponding menu commands. 

You can quickly change the format of the selected data record or axes by using the Speed Buttons. 

10.2.1 Formatting of Graphs 
The menu labelled Graphs lists the (selected) data records that can be displayed in graph, chart or table 
form. 

For each data record the menu command Own Y-Axis enters an additional y-axis into the diagram 
assigned to the data record selected. 

Under Graphs you can select a data record and at the next menu level select a variety of formatting 
options. Here you can select line graph or bar chart format and bold or normal line display. 

With change color you can select from a wide range of colors for the lines or bars in your graph or chart. 

By choosing the command invisible the selection is suppressed but not deleted. 

10.2.2 Formatting the X-Axis 
In this dialog window you can define the time period to be displayed in a graph or chart as well the time 
period over which the data record values are to be summarised or averaged out. 

Column Width 
The column width represents the time period within which the data is presented. Depending on which 
unit you have selected, the data record values are either summarised (energy) or averaged out (power 
output, temperatures) for the interval selected. 

Display From 
The date from which the data displayed in the graph should begin is entered here (in date format). 

Display Interval 
Here you should enter the period over which the data should be displayed in the graphic. 

Units 
The choice of units for the bar width and display interval (hours, days, weeks, years) is made from the 
pull down menus. You will need to enter the multiples of these units in the fields provided. 

10.2.3 Formatting the Y-Axis 
The y-axis is formatted in this dialog window. 
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Unit 
Select the unit to be displayed from the field labelled Unit. If you select Position on Right the y axis will 
be placed on the right-hand side of the diagram. 

Position of the Y-Axis 
In this field you can select the cross-over point of the axes. You can select either minimum (zero) or 
maximum, or you can enter a value yourself. 

By selecting the field Own Scale you can format another y-axis for the selected data record. 

Minimum Value 
Enter the smallest value to be illustrated for the data record. 

Maximum Value 
Enter the largest value to be illustrated for the data record. 

Main Intervals 
The labelled intervals along the y-axis. 

Sub-Intervals 
The division of the main intervals along the y axis. 

10.2.4 Printing Graphics 
The usual WINDOWS print dialog appears in which you can select the settings and printer desired. 

10.2.5 Graphics in Table Format 
The graphs selected in the Energy and Climate Data... dialog window can be displayed in table format. 
Just click on the Table menu to switch to table format. 

The various recording stages and intervals are incorporated from the graph into the table. If you want to 
change these go to the menu Axes/X-Axis, and make the changes in the dialog window. You can also 
quickly change the display interval units from the Display menu. 

Clicking on the menu Line/Bar switches back to line graph/bar chart format. 

The position of the decimal point depends on the y-axis’ main interval setting. To Edit the main interval 
setting you have to first go back via the Line/Bar menu and then to Axes/Y-Axis. You can then make 
amendments to the main interval or the units and then go back to Table. 

From the File/Save As menu you can save the results as an ASCII file and from File/Copy you can copy 
the values for pasting into other spreadsheet programs such as EXCEL (or use the speed button). 

10.2.6 Graphics Screen Speed Buttons 
By using the speed buttons you can perform a variety of functions and quickly change the format of the 
selected parts of the graph or chart or axis. 

 

Print Graphic. 

 

Copy Graphic (eg to paste into EXCEL for further processing). 

 

Go to next or previous time period. 
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Go to first or last time period. 

 

Enlarge or reduce font size of selected area of graphic. 

 

Change between normal and bold font in selected area of graphic. 

 

Change font. 

 

Change selected data record to line graph or bar chart. 

 

Add grid lines. 

10.3 Payment Received for Grid Supply 
This menu point is first activated after a simulation has been carried out. 

The tariff forming the basis of the calculation is shown in the Tariff Name field. 

Energy fed into the grid is shown separately for high and low tariff rates and for summer and winter. 

The remuneration received for the electrical energy is provided on the basis of the tariff selected and the 
amount of energy exported to the grid. 

The calculation results for the Payment Received for Grid Supply are printed in the Economic Efficiency 
Calculation. 

10.4 Grid Electricity Costs 
Here you are given a detailed list of variables for energy use under the headings: Kilowatt-Hours, Load 
and Discounts/Supplements, and the resulting costs (payments to the electricity utility). The values are 
given for two scenarios: With PV System and Without PV System. 

Without PV System - the cost of electricity used is determined by the energy consumption of the 
electrical appliances. 

With PV System – the cost of electricity used is determined by the amount of energy drawn from the grid. 

Depending on the supply concept (see Tariffs), the energy used by the electrical appliances plus the 
energy used by the PV system itself is provided exclusively by the grid (Full Supply), or, with the Own 
Use concept, the amount of energy generated by the PV system must be deducted from this amount. 

The name of the tariff on which the calculation is based is shown in the field at the top of the window. The 
tariff is defined under the menu point Conditions/Tariffs. 

The results of the tariff calculation are given in a detailed table, divided into three sheets. A summary 
with the final result Total Payment is given in a field at the bottom of the window. 

  

Kilowatt-Hours: 
Specific Costs: Average specific costs in the given period. 

Kilowatt-Hours from Grid: The number of kilowatt-hours of energy drawn from the grid in the given 
period. 

Costs: costs before the deduction of discounts and the addition of supplements. 
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Payments: costs after the deduction of discounts and addition of supplements. 

Load: 
(see also the dialog: Power Measurement). 

Set Load Price: the set demand price as entered or the estimated price for wholesale provision of power 
to the utility. 

Heavy Load Peak: for heavy/light load capacity measurement, the heavy load peak is given here. 

Billing Load (Output Value): The output that is included in the billing calculation is given here, or, if a 
96 hour tariff is in use, the output value is given. 

Specific Load Price: Average specific load price in the given time period. 

Consumption Dependent Load Price: billing load * specific load price. 

Total Power Payment: represents the sum of the set and consumption dependent power prices after 
deduction of discounts and addition of supplements. 

Discounts/Supplements: 
Set Costs: The set costs defined in the Discounts and Supplements dialog. 

Hours of Full Utilisation: from quarter hour power measurement, the total hours of full utilisation and 
the resulting load utilisation period discount are provided. 

Other Discounts, Supplements: the rebates and supplements entered in the ”Discounts and 
Supplements” dialog are also shown here. 

You are not able to enter values in this window. 

10.5 Pollutant Emissions 
This menu point is activated after simulation has been completed. 

Here you can view the values for the pollutant emissions that have been avoided by use of the PV system. 

The evaluation of pollutants varies for energy consumption and for energy provision to the grid. 

With the ”Own Use” supply concept (see Tariffs) the energy supplied by the PV system replaces the 
energy from the grid. This is evaluated in the Pollutants dialog in the column labelled ”Specific Pollutant 
Emissions per kWh of Electricity” for the electricity consumed by the appliances. 

The electricity supplied to the grid by the PV system is also evaluated in the Pollutants dialog, as a value 
of ”Specific Pollutant Emissions per kWh of Electricity” avoided by feeding the energy into the grid. 

Emission values required for the calculations are entered under the menu heading Conditions/Pollutant 
Mix. 

10.6 Project Report 
The results of the simulation are presented and can be printed out in the Project Report. 

There is a one page Summary containing the most important simulation results and a multi-paged 
Detailed Project Report, that also contains the results of the Economic Efficiency Calculation. 

10.6.1 Detailed Project Report 
The Detailed Project Report is made up of three sections and can be viewed in preview (see Page Layout). 
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The first section gives the System Data for the PV system (System menu) and the appliances (Appliances 
menu). The types of modules and inverters used are given in the details for manufacturer, type, output 
and efficiency. 

The system data can also be produced before simulation. 

In the second section, the Detailed Results are presented. These basically consist of the Annual Energy 
Balance results plus a number of other results. 

In addition, a graph illustrating the solar energy produced, the energy requirement and the supply of 
energy to the grid is provided. With the supply concept “Full Supply” the solar energy produced equals 
the amount of energy supplied to the grid. 

In the third section the Economic Efficiency for stand-alone systems can be printed. If you want to 
change the parameters (investment, subsidy, interest etc) go to the Calculations/Economic Efficiency 
Calculation... dialog. For grid connected systems, the Economic Efficiency Calculation can be printed 
from the Economic Efficiency Calculation – Grid Connected systems dialog. 

You can print the roof layout as a separate document via the menu: Results > Project Report > Roof Layout. 
This function is only active if the roof layout has been used in the project. Alternatively, you can select 
the detailed project report via the menu: Results > Project Report > Detailed Project Report, and then 
decide whether you want to include the roof layout in the detailed project report. If so, select the Roof 
Layout option. 

All three sections can be printed separately. Click on the 

button and a Print dialog appears showing the sections that can be printed and the number of 
copies. 

10.6.2 Print dialog 
The standard printer is the printer selected in WINDOWS’ system settings. If you want to print to another 
printer, go to the Select Printer dialog by clicking on the Settings button. 

In addition, towards the bottom of the dialog, you can see the Subjects that can be printed out. 
(Normally only one title is included.) At least one subject must be selected. 

The number of copies that you want to print should also be entered in this window. 

10.6.3 View Page Layout 
This dialog allows the page layout of documents that can be printed to be viewed before printing. 

Where there are number of pages, you can move easily between pages: 

• either click on the arrow buttons     in the menu bar, or 
• or use the scroll bar on the right of the screen. 

If there is only one page, no arrows are displayed. 

When scrolling down a page (click on the black arrows in the scroll bar) the page will move to reveal any 
part of that page that is out of view, or the screen will move straight to the next page. 

If the cursor is positioned within the area where it appears as a magnifying glass , the page 
being viewed can be enlarged or reduced. A ”+” in the magnifying glass means that the view area can be 
enlarged, and a ”-” means that the view area can be reduced. The area directly around the magnifying 
glass is enlarged. 
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Click on the printer symbol button   to open the Print dialog. 

10.6.4 Summary Project Report 
This dialog is a page preview (see Page Layout) of the one-paged project summary. This can also be 
printed out. 

The System Diagram is shown. Each sub-array is allocated a PV symbol with details on the number, 
manufacturer and type of modules, the power output, tilt, orientation and type of mount. If the design 
includes multiple inverters the sketch will also include an inverter symbol for each sub-array, indicating 
the number, manufacturer, type and output. Depending on the supply concept selected (Own Use or Full 
Supply), the meter symbols are arranged differently. Values for the supply to grid tariff and the 
appliances’ annual consumption are given as text with the appropriate symbol. 

The annual results are basically the results of the Annual Energy Balance for the entire system. In 
addition, the level of CO² emissions avoided is given in the pollutant balance results. 

10.7 Variant Comparison Selection 
In this window you can select the projects you want to compare in table format from the list of existing 
projects. 

After the selection of systems has been made (not available with PV*SOL®-N for grid connected systems 
only), the projects will be shown together in a table – grid connected or stand-alone systems are grouped 
and listed separately . 

A selection is made by marking the project required and moving it into the selection list. 

 

Click on this button to select the projects. You can also drag and drop highlighted 
projects into the list. 

 

With this button you can deselect projects from the list. Click on the field labelled 
Current Project to load the current project into the comparison table, provided it 
belongs to the selected system type. 

Comparison Table 

Click on OK to exit the dialog and another dialog opens in which the most important parameters and a 
summary of the simulation results are displayed. 

The window has its own menu with the Close and Copy commands. The Copy command copies the table, 
so that the variant comparison can be pasted into external spreadsheet or word processing programs for 
evaluation and printing out. 

The dimensions produced are different for grid connected and stand-alone systems. The table headings, 
however, remain the same for both systems. 

Table Headings 
File Name: the file name is set when the project is saved. If the current project has been selected but not 
yet saved, the file name Current Project is allocated. Otherwise the file name is given without the 
directory path – eg Solar1.prj. The current project’s file name is displayed at the top of the main screen. 

Variant Reference: the project variant reference can be entered at the top of the main screen or is given 
as the file reference when saving the project. 
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Project Name: the name of the current project is entered in the first line of the ”Project Administration” 
dialog and shown at the top of the main screen. 

Climate data file: the climate data for the current project is also displayed at the top of the main screen. 
The climate data file that was last loaded is used for all new system designs. The climate data can be 
changed via the Conditions/Load Climate Data File menu. Climate data files have the file extension 
*.wbv. 

10.7.1 Variant Comparison 
The projects selected in the Variant Comparison... are set out in a table in this dialog. 

The most important parameters are shown, as is a summary of the simulation results. 

The window has its own mini-menu with the Close and Copy commands. 

The Copy command copies the table so that you can paste the variant comparison table into spreadsheet 
programs such as EXCEL or into word processing programs. 
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11 Database Menu 
From the Database menu you can view the various database sections, make changes and add new files. 

When entering the project data you will have to load the individual components for the PV system from 
the database files. 

  

During the design and configuration of a project it is not possible to change the component values from 
the project screen, with the exception of the To Grid Tariff and the Individual Appliances. See also 
Project Design.  

è see also: 
Editing Projects 

Using Data from Databases 

11.1 PV Module 
Here, on a number of worksheets, you can set the characteristics for the PV modules. Details on using the 
database are given under Project Design. 

As in all database dialogs, there are the Load, Save and Close buttons and there is also a Print button. 

11.1.1 Worksheet 1 – Basic Data: 
Manufacturer and Type are allowed a maximum text length of 50 characters. 

Output Tolerance [%] 
The given module values are subject to fluctuations during manufacture. This is relevant mainly for the 
specification of current, voltage and power output. 

Cell Type 
The majority of cells consist of mono-crystalline or poly-crystalline silicon, with a few made of amorphous 
silicon. 

New cell types will, however, soon be available. 

Dimensions: Height [m], Width [m] 
The height and width determine the module surface and therefore the PV array surface area. This surface 
area, based on the measurement of the modules, is referred to in the program as the Gross Module 
Surface Area. 

11.1.2 Worksheet 2 - U/I Characteristics under STC: 
The specifications on this page are only valid for standard test conditions (STC). This means a module 
temperature of 25°C, a sunlight spectrum of AM 1.5 and 1000 W/m² irradiation. 

MPP Voltage [V], MPP Current [A] 
The power output of the modules is dependent on the module temperature and irradiation, and the 
module voltage. For each module temperature and irradiation value there is a current/voltage 
characteristic curve, and the working point on this curve determines the modules’ power output. 
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The MPP is the working point on this curve (see also the U/I characteristic curve button on the sheet: U/I 
characteristics - part load) where the power output of the modules is the greatest (Maximum Power 
Point). 

The MPP voltage and the MPP current are dependent on temperature and irradiation. This means that the 
voltage and current given here are only valid for standard test conditions. For all other irradiation and 
temperature values there is another MPP. This must be defined by the program (see: U/I characteristics - 
part load). 

Within the PV system this task is carried out by the inverter, which regulates the voltage of the PV 
generator to maximise current and voltage production (MPP tracking). 

No-Load Voltage [V] 
The voltage that arises when the module is load free. This value is also dependent on temperature and 
irradiation. 

Short Circuit Current [A] 
The electricity that flows through a short circuited module. This is also temperature and irradiation 
dependent. 

Specified Power Output [W] 
The power output that the module produces under standard test conditions according to the 
manufacturer’s data sheets. The actual power output is defined from the module voltage and the module 
current, and is given in the Calculated Power Output field. In defining the installed PV power output, 
PV*SOL® always refers to the calculated power output. 

Efficiency [%] 
The module efficiency rate under standard test conditions. For the simulation, the program determines 
the Solar Module Surface Area from the calculated power output and efficiency with the following 
formula: 

Nominal output(STC) = 1000 W/m² * ETA(STC) * Solar module surface area  

11.1.3 Worksheet 3 - U/I Characteristics under Part Load Conditions: 
Current and Voltage for a second working level are entered on this page. The values for a lower level of 
irradiation are important in order to be able to calculate the module efficiency curve. The efficiency 
specifications in data sheets are based on a module temperature of 25°C and irradiation of 1000 W/m², 
although for most of the year these levels are seldom reached. The efficiency rate at a lower level of 
irradiation is therefore very important for the simulation results. There are a number of important points 
to consider when determining the second working point (Module Efficiency - Part Load). Click on the Help 
button to view these. The program will calculate the second working point for you if you click on the 
Typical Part Load Efficiency button. 

You can view a graph of the characteristic curve calculated by the program by clicking on the Efficiency 
Curve, U-I Curve or U-P Curve buttons. 
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11.1.4 Worksheet 4 – Other Characteristics: 

Temperature Coefficients: 

Voltage Coefficient [mV/K] 
This value expresses how many degrees the voltage decreases when there is a rise in module 
temperature. The hotter the module, the lower the voltage, ie this coefficient is negative. 

Current Coefficient [mA/k] 
This value shows by how many amps the current increases when the module temperature rises. The 
higher the module temperature, the higher the current, ie this coefficient is positive. 

Power Output Coefficient [%] 
The hotter the module, the lower the power output. This coefficient is negative and is proportional to the 
nominal output. 

Incident Angle Modifier [%] 
The incident angle modifier is a characteristic of the material covering the module (glass). The glass 
reflects part of the radiation away from the module resulting in a loss of current. The incident angle 
modifier reduces the amount of direct radiation falling onto the module. The correction factor for diffuse 
radiation lost through reflection is assumed at 95%. 

Maximum Module System Voltage[V] 
Each electrical appliance has a maximum voltage limit. This value refers to the maximum voltage that a 
sub-array can support in order to ensure that no damage is caused to the modules. If the maximum 
voltage is too high, you should reduce the number of modules in series. 

Specifications for the Dynamic Temperature Model: 
Heat Capacity [J/(kg*K)], Absorption Coefficient [%], Emissions Coefficient [%], Weight [kg] 

These are the parameters for the dynamic temperature model required for working out the thermal 
balance equation. 

1. Click on Load to load one of the module files provided, to check on the values and correct if required. 

2. Click on Save to save the values you have entered, either in the current file or as a new file. A 
message appears before a file is overwritten. 

3. Close exits the dialog without a message appearing. 

If you want to print out the file that has been loaded last click on Print. This will be printed on the 
standard printer as specified in printer set-up. 

11.2 Module Part Load Operation 
The module’s operation under part load conditions is calculated from the specifications for no-load 
voltage, short circuit current, MPP voltage and MPP current with low irradiation and a module 
temperature of 25°C. 

The second working point, ie the choice of irradiation level, has to be set under certain restrictions. It 
must be selected so that, at the irradiation point set, the fill factor is at maximum, or so that, with lower 
irradiation, the fill factor becomes considerably smaller and with higher irradiation the fill factor is 
around the maximum value. 
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The definition of the fill factor is: 

FF = (MPP current * MPP voltage)  / (short circuit current * no-load voltage) 

The fill factor (FF) is dependent on the irradiation. If a FF above the irradiation is applied, this results in 
the fill factor function. Depending on the module and the irradiation, the FF is usually set at around 55% 
and 85%. 

If you don’t have any suitable specifications for part load operation, you can run the calculation with 
standard values by clicking on the Typical Part Load Operation button. 

For most modules, the irradiation at the fill factor maximum is 300 W/m². The fill factor is set at 5% above 
the FF under standard test conditions. Linear part load operation is given for the current. 

After you have entered the values for module part load operation, it is essential to take a look at the 
efficiency characteristic curve and to test that there are no discrepancies. 

11.3 Inverter – Grid Connected Systems 
The characteristics for the inverter are entered in this window. Details on using the database are given 
under Project Design. 

If you want to enter an inverter that can be switched to different voltage levels, you will have to enter the 
individual voltage fields as separate inverters with the characteristic data for each of these. 

As in all database dialogs there are the Load, Save and Close buttons and there is also a Print button. 

  

Manufacturer and Type are allowed a maximum text length of 50 characters. 

DC Power Rating [kW] 
DC stands for direct current and refers to the input side of the inverter. As this value is not clearly defined 
by inverter manufacturers, it is no longer used in PV*SOL and is shown for information only. 

Max. DC Power [kW] 
This value is also not clearly defined by inverter manufacturers. It is no longer used in PV*SOL and is 
shown for information only. 

AC Power Rating [kW] 
AC stands for alternating current and refers to the output side of the inverter. The AC power rating is the 
output that the inverter is designed for when in continuous operation.  When the inverter is in continuous 
operation the power output is limited, with the AC power rating being the upper limit. 

Max. AC Power [kW] 
The output that the inverter can produce in 10 minutes. This value is not currently used in PV*SOL. 

Stand-by Consumption [W] 
If no energy is being delivered into the grid or to the electrical appliances, the energy required by the 
inverter itself still has to be accounted for. In addition to the stand-by consumption there is also night 
consumption. 

Night Consumption [W] 
The inverter switches itself off during the night, but still uses a small amount of energy. 
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Input Level [W] 
The minimum amount of energy to be produced by the PV generator before the inverter can function. 

Nominal DC Voltage[V] / Nominal DC Current [A] 

The input voltage or the input current of the inverter, when delivering nominal power output. 

Number of MPP Trackers 
The number of independently operating MPP regulators. 

For multi-string appliances, this value is greater than 1. 

Max. Input Current per MPP Tracker [A] 
This current limit per MPP tracker should not be exceeded. (Only active if the number of MPP trackers is 
greater than 1.) 

Max. Recommended PV Output per MPP Tracker[kW] 
See Max. Recommended PV Output [kW] 

Maximum Input Voltage [V] / Maximum Input Current [A] 
This level of voltage or current should not be exceeded, otherwise the inverter will be damaged. 

Upper and Lower Voltage Levels for the MPP Range [V] 
Within this voltage range, the inverter is able to control the MPP tracking. The inverter finds the optimal 
voltage for the PV generator within this range, so that the generator’s power output is maximized. 

MPP Adjustment Efficiency [%] 
The adjustment efficiency provides a measurement of how close the inverter’s working point is to the PV 
generator’s maximum power point (MPP). The program differentiates between the power ranges <20% 
and >20% of the nominal output. The adjustment efficiencies are taken into account during simulation in 
defining the inverter’s performance ratio. 

Characteristic Curve - Inverter 
This button opens the Characteristic Curve – Inverter dialog, so that the you can enter the conversion 
efficiency depending on the input power. These values should be obtained from the inverter 
manufacturer. 

The European efficiency is calculated with the following formula: 

Wg(EU) = 0.03*Wg(5%) + 0.06*Wg(10%) + 0.13*Wg(20%) + 0.1*Wg(30%)+ 0.48*Wg(50%) + 
0.2*Wg(100%) 

Deviation of the Input Voltage from the Nominal Voltage 
The inverter’s efficiency characteristic curve is entered for the nominal voltage. If the inverter is not 
operated at its nominal voltage, there is a change in the efficiency of the inverter. Whether the efficiency 
increases or decreases is dependent on whether the inverter has a transformer, or not. The following can 
be used as a rule of thumb: 

The efficiency of an inverter with a transformer reduces with rising input voltage by about 1% per 100 V. 

The efficiency of an inverter without a transformer increases with rising input voltage by about 1% per 
100V. 

1. Click on Load to load one of the inverter files provided, to check on the values and correct if required. 
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2. Click on Save to save the values you have entered, either in the current file or as a new file. A 
message appears before a file is overwritten. 

3. Close exits the dialog without a message appearing. 

If you want to print out the file that has been loaded last click on Print. This will be printed on the 
standard printer as specified in printer set-up. 

è See also: 
Inverter 

Inverter – Stand-Alone Systems 

11.4 Inverter – Stand-Alone Systems 
The characteristics for a stand-alone system inverter are entered in this window. Details on using the 
database are given under Project Design. 

Manufacturer and Type are allowed a maximum text length of 50 characters. 

Nominal DC Output: 
The direct current flows into the inverter. The nominal output is the power rating at which the inverter, 
under continuous operation, is designed to run. 

Nominal AC Output: 
This refers to the current that flows out of the inverter. The nominal AC output is the power rating that is 
available for the electrical appliances connected to the system. 

Stand-by Consumption [W]: 
If no energy is being delivered into the grid or to the electrical appliances, the energy required by the 
inverter itself still has to be accounted for. 

Nominal DC Voltage: 
The nominal DC voltage must match the battery’s nominal voltage. 

Nominal AC voltage: 
The voltage corresponds to the nominal voltage of the appliances. 

Characteristic Curve - Inverter: 
This button opens the Characteristic Curve – Inverter dialog, so that the you can enter the conversion 
efficiency depending on the input power. These values should be obtained from the inverter 
manufacturer. 

è See also: 
Inverter 

Inverter – Grid Connected Systems 

11.5 Inverter Characteristic Curve dialog 
The conversion efficiency is the relationship of the power output to the power input, dependent on the 
inverter power at that time. 
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The specification of the efficiency given in manufacturers’ data sheets relates to the nominal output 
(power rating), which PV systems, however, are not able to deliver at most times of the year. Therefore 
the part load operation is much more important for the simulation results. 

The program requires 7 support points to define the characteristic curve, ie the efficiency at 0, 5, 10, 20, 
30, 50 and 100% of the nominal output. 

To view the characteristic curve in graphic form, click on the Graph button. 

For grid connected systems, the European efficiency support points are fixed and displayed. If changes 
are made, these are first calculated on exiting the entry field. 

è See also: 
Database: Inverter 

11.6 Battery (not available with PV*SOL®-N) 
The following battery characteristics are entered in this dialog: 

Manufacturer and Type: 
You are allowed to enter a maximum of 50 characters. 

Voltage: 
The battery’s nominal voltage. 

C20 Capacity: Battery capacity with a discharge time of 20 hours. 

Capacity: 
The product of voltage and C20 capacity. This is calculated within the program by clicking on Calculator. 

Self-Discharge: 
The details from the battery’s product data sheet should be recalculated to % per day. 

Average Charge and Discharge Efficiency: 
If you do not have these specifications to hand, please use the program’s default values. 

1. Click on Load to load one of the battery files provided, to check on the values and correct if required. 

2. Click on Save or Save as… to save the values you have entered, either in the current file or as a new 
file. A message appears before a file is overwritten. 

3. Close exits the dialog without any message appearing. 

If you want to print out the values from the file that has been loaded last click on Print. The information 
will be printed on the standard printer as specified in printer set-up. 

11.7 MPP Tracker (not available with PV*SOL®-N) 
MPP trackers are not standard system elements, but are produced especially for the various stand-alone 
systems. They are also partly integrated into other system parts (charge controller). 

For the MPP tracker the following data is required: 

Reference: 
The text entered is shown as the file reference in the load file dialog. 



11 Database Menu Manual PV*SOL Expert 5.5 

Dr. Valentin EnergieSoftware GmbH  78 / 98 

Nominal Output: 
The nominal output corresponds to the power output of the PV generator. 

Upper and Lower Voltage Levels for the MPP Range [V]: 
The MPP tracker functions within this voltage range. The MPP tracker finds the optimal voltage for the PV 
array within this range, so that the array’s power output is maximized. 

MPP Adjustment Efficiency [%]: 
The adjustment efficiency provides a measurement of how close the MPP tracker’s working point is to the 
PV array’s maximum power point (MPP). 

Characteristic Curve – MPP Tracker: 
This button opens the ”Characteristic Curve – MPP Tracker” dialog, so that the you can enter the 
conversion efficiency depending on the input power. The program requires seven values to be entered for 
the characteristic curve: the efficiency at 0, 5, 10, 20, 30, 50 and 100% of the nominal power. 

1. Click on Graph to view the characteristic curve. 

2. Click on Load to load one of the MPP tracker files provided, to check on the values and correct if 
required. 

3. Click on Save or Save as… to save the values you have entered, either in the current file or as a new 
file. A message appears before a file is overwritten. 

4. Close exits the dialog without any message appearing. 

11.8 Load Profile 
The electrical load profile dialog appears, which shows an hourly breakdown of consumption and the 
annual consumption in both chart and table format. For more information on how to use the database 
see: Project Design. 

With the Load and Save buttons you can open the Load and Save File dialog and you are able to load a 
file from the database or save a file to the database. 

By clicking on the tabs above the chart you can view the various loads for the type of day selected, both 
in chart and table format. 

If you want to Edit the profile values, you can do this in the table: 

Click on the value to be changed within the table. 

The hour and its corresponding value are highlighted. 

The value appears in the field at the head of the table. 

Key in the new value. 

Click on any other value in the table. 

The new value is loaded and appears in the chart. 

If the values split over 24 hours do not add up to 100%, the program will do this if you click on the 100% 
button. 

  

With the Copy and Add buttons you are able to copy a consumption profile for one typical day to another: 

Load the profile that you want to copy by clicking on the tab above the chart. 
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Click on Copy. 

Change to the profile that you want to overwrite with the profile you have copied (click on the tab above 
the chart). 

Click on Add. 

11.9 Individual Appliances 
The energy requirement for the individual appliances is defined in this dialog. 

The individual appliances are an exception among the database files, in that you are able not only to 
select the appliances from the ”Individual Appliances” dialog, you are also able to define them from 
within this dialog. However, you are still able to create and amend individual appliance profiles from 
within the database. 

The following data is required: 

Name: The text entered appears as a file reference in the ”Load File” dialog. 

Type: Click on the arrow button to view a list of the types of appliances available. The subdivision 
assists in the optimum setting of operating times, which is why the dialog distinguishes between the 
various types. 

• User-Independent Appliance 
• User-Dependent Appliance 
• Short-Time Use Appliance 
• Light 

Output: the entry should include all appliances. 

Monthly Operation Bar: click on a field above a month to switch off operation for the whole of that 
month (the field turns from green to white). Click on the magnifying glass to switch off operation for 
individual days. (Green field = in operation, white field = not in operation.) 

By clicking on Load you are able to load an appliance from the database, in order to change the data 
provided. 

If you click on Save you are able to save the values entered into the existing file or as a new file. 

Click on the Graphics button to view the calculated energy requirement for the appliance in various 
formats: graph, chart, table. You are able to save and print these, and also copy into other 
documents/programs. 

11.10 From Grid Tariff 
The tariff for electricity from the utility grid used by the electrical appliances is defined here. For more 
information on how to use the database see: Project Design. 

From the Load and Save File dialog and you are able to load a tariff file from the database or save a tariff 
file to the database [*.tar]. 

The tariff reference is given in the field labelled Name. 

High Tariff and Special Tariff Periods are defined in the Tariff Time Periods dialog. These times are valid 
for electricity drawn from the grid as well as for energy exported to the grid. 

The kilowatt-hour prices for each tariff time period (ie HT – high tariff, LT – low tariff and ST – special 
tariff) are entered in the Kilowatt-Hour Price dialog. 



11 Database Menu Manual PV*SOL Expert 5.5 

Dr. Valentin EnergieSoftware GmbH  80 / 98 

Click on the Power Measurement button to define the type of power measurement (¼ hour power 
measurement, 96 hour measurement) In addition, the prices for the energy provided by the grid utility is 
defined here and the light or heavy load periods are entered. 

The grid utility discounts and supplements can be entered separately in the Discounts and Supplements 
dialog. 

11.11 To Grid Tariff 
Unlike the other database files, the To Grid Tariff can be selected and defined in both the 
Conditions/Tariffs menu dialog and in the Economic Efficiency Calculation... dialog. However, you can 
also define the To Grid Tariff via the Databases menu in the main menu bar. 

A reference describing the data record can be entered in the upper text field. 

Period of Validity for Tariff 
For the first years, the To Grid Tariff is usually set at a higher rate. Thus you can take account of any 
subsidised electricity provided for a set period, following which the legally set minimum rate is paid. 

To Grid Tariff after … Years 
Here you are able to define a different To Grid Tariff which is received following the initial period. 

Number of Power Levels 
Here you can set the number of Power Levels required to define the different To Grid Tariffs. 

Tariff Zones/Graduated Tariff Rates 
The method used for calculating the resulting Payment Received for Grid Supply varies according to the 
selection of either Tariff Zones or Graduated Tariff Rates. If Tariff Zones is selected, the result is an 
almost constant change in the payment, whereas the selection of Graduated Tariff Rates produces a jump 
from one payment rate to the next when the defined Power Level is reached. 

Tariff Zones: 
A mean To Grid Tariff for all Power Levels up to the Installed PV Power is calculated. For example: 

0-30 kW - €1 

From 30 kW - €0,50 

A system size of 50 kW therefore produces a Payment Received for Grid Supply of 30/50*€1 + 
20/50*€0,50 = €0,80.per kWh. 

Graduated Tariff Rates: 
In this case the To Grid Tariff is calculated direct from the Installed Power. Using the above example, this 
would result in a Payment Received for Grid Supply of €0.50 per kWh on all electricity supplied. 

Payment Received for Grid Supply – High Tariff/Low Tariff different 
If this option is selected, an additional field appears in which you can enter the To Grid Tariff at two 
different rates: a High Tariff and a Low Tariff. 

The timings for High and Low Tariffs are the same as those for the From Grid Tariff. The timings are 
therefore dependent on the From Grid Tariff. 
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11.12 Pollutants 
You can define a new pollutants file here, which can then be loaded into a project from the 
Conditions/Pollutant Mix menu. 

In the Text field a file reference describing the data record is given, that was entered when saving the 
file. 

Different values are required for simulating grid connected and stand-alone systems. 

Grid Connected Systems 
In the first column you need to enter the specific pollutant emissions that occur on production of the 
electricity required to supply energy from the grid. 

In the second column you need to enter the specific pollutant emissions that are avoided by feeding PV 
energy into the grid. 

This kind of differentiation is necessary when it can be expected that the grid utility will use different 
power plants for producing high and low peak electricity. For example the energy fed into the grid could 
suppress basic load electricity production with energy drawn from the grid occurring during peak times. 

Stand-Alone Systems 
For stand-alone systems the pollutant emissions for the Back-up Generator are given. 

Click on Load to load a new pollutant evaluation file from the database or on Save to save new 
specifications to the database. 

All emissions files must have the file ending *.emm. The directory that appears on opening the dialog can 
be set under Options/Drives. 

The database that comes with the program consists of values from the Integrated Systems Total 
Emissions Model (GEMIS), published in 1990 by the German state of Hesse’s Ministry for the 
Environment, Energy and Federal Matters. 

11.13 Loans 
From here you can enter the parameters for any loans taken out to finance the PV system. 

Details on using the database are given under Project Design. 

As in all database dialogs, there are the Load, Save and Close buttons and there is also a Print button. 

The entry parameters for a loan are: 

Reference 
The reference, with a maximum text length of 50 characters, is required for selection in the Financing 
dialog of the Economic Efficiency Calculation. 

Loan Capital 
The amount of the loan is entered as a percentage of the investment volume. 

Term 
The time period that has been arranged for paying back the loan. 

Loan Interest 
The amount of interest that has to be paid on a loan. 
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Repayment-Free Initial Period 
The years in which no loan repayment is required. A maximum period of two years is allowed. 
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12 Options Menu 
The Options menu is used to enter specifications that are independent from the program and to define 
the basic settings for the use of the program. 

12.1 Paths... 
You are able to define the directories for all file types by clicking on the corresponding button. A directory 
dialog opens in which you can define a new directory path. 

These settings are required in the program for standard drive selection in the Load and Save File dialog. 

The individual components are searched for and saved in the following standard sub-directories: 

  File Extension 

Projects .prj 

PV-Modules .mod 

Inverter (Grid Connected) .wrn 

Inverter (Stand-Alone) .wra 

Batteries .acc 

To Grid Tariff .eta 

From Grid Tariff .tar 

Loads .slg 

Individual Appliances .vbi 

Pollutants .emm 

MPP Tracker .mpp 

Shade .sch 

Loans .cre 

12.2 Settings 

Worksheet Projects 
• On the worksheet, Projects, you can specify with which project the programme should open. You 

can select that either a new project or the last project worked on appears each time the 
programme is started. 

• “No monitoring of project components” gives you the option of selecting that various 
Messages appear (click on field) or do not appear (leave field blank) during programme use: 

• Select a standard feed-in tariff for new projects. This should be an .eta-file. The selected tarifr is 
displayed. 

• Select either metric or imperial (U.K.) units. 
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Worksheet System Check 
Here you can enter the settings that are required for the System Check. 

Temperature and irradiation maximums are usually calculated from the Climate data file. 

However, if you are certain about the maximum values that you wish to use as the basis for system 
calculation, you can enter these as the set values. 

è See also: 12.2.1 System Check 

Worksheet Background Image 
• Define whether the current system or an uploaded image should be the program background.  

Load an image for grid connected systems and stand-alone systems, each. 

Worksheet Calculation Model 
Select whether the Dynamic Temperature Model or the Linear Temperature Model is to be used. 

Please note that these setting remain in force after you exit the project. 

The temperature of the PV module is important for calculating the power output. Temperature increase of 
10°C leads to a power loss of about 5%. 

With the Simple Temperature Model the module temperature is determined in linear dependence on the 
irradiation: 

T module = T external + U * (G / Gstc), 

and k is dependent on the type of module mount. 

With the Dynamic Temperature Model, the thermal balance equation is solved. The 1 hour simulation 
step is, if required, subdivided into minute-long time steps. 

To solve the thermal balance equation, the following module data (see database: PV Module) is required: 
module mass, heat capacity, absorption coefficient and emissions coefficient. In addition, the scalar 
wind speed from the Climate data files, as well as the height of the system, (see dialog: Technical 
Data/Calculation Model/Losses) are included in the calculation. 

As the subdivision of the calculation steps leads to a considerably longer simulation time, and, for rough 
calculations, the simple temperature model is perfectly adequate, the user is given the option to carry 
out the calculation with whichever temperature model is preferred. 

Worksheet Project report 
• Define your company's contact data for the project report. 
• Define Company Logo for Project Report Heading 

Select a logo to appear in the header of the project report.  
• If you select “Show Company Logo on Screen”, the logo appears on PV*SOL’s main screen as a 

background image. 
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Worksheet Update Check 

è Prerequisite: active internet connection 

è The program checks whether a new update is available on the server according to the settings 
on the page Internet update: 

• Daily at first program start 

• Or on clicking Check now … . 

• If you are using a proxy server, you can enter the required settings here.    
• If a new release or new databases are available, the program will close and the installation 

program will be downloaded to the Desktop and run from there. 

12.2.1 System Check 
In order to check the interconnection of modules and inverters or MPP trackers and batteries, and the 
influence of losses in the direct current cabling, click on the System Check button before exiting the 
Technical Data dialog. Depending on the system connections the system check takes place on one or a 
number of pages. 

If new Settings for temperature and irradiation maximums have been entered under Options/Settings, 
you will be reminded of this by a message at the base of the window. 

No Discrepancies 
You should only exit the ”Technical Data” dialog when, after the system check, the following message 
appears: 

On checking the system no discrepancies have been found! 

Further Calculation Possible 
If discrepancies appear, but a simulation of the system is still possible, the following message appears: 

Please check the system parameters! Further calculation possible. 

Incorrect Database Data 
The system check requires that module and inverter data is saved in the database. If specifications are 
missing, or if the specifications are not physically possible, a message appears: 

The database files contain incorrect values! 

Select Components 
If you go to the system check before loading the module and inverter specifications, this message 
appears: 

Please select components from the database files available! 

Check System Parameters 
If during the system check errors are found that have to be corrected before simulation can take place, 
the message is: 

Simulation is not possible until you have checked and corrected the system parameters! 

The following checks occur for grid connected systems: 
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Output checks 
The inverter’s nominal output and maximum PV output are compared with the installed PV output per 
inverter. The inverter’s capacity is defined from the PV output divided by the inverter’s nominal output. A 
message appears if the capacity is less than 90% or more than 110%. Capacities less than 20% and more 
than 300% are not accepted. 

If the PV output is larger than the inverter’s nominal output, the inverter must reduce the output to the 
inverter’s nominal output. If the PV output is significantly less than the inverter’s nominal output, the 
inverter works at a low efficiency rate. 

MPP Voltage Check 
The inverter’s MPP tracking field is compared with the MPP voltages of the modules connected in series. 
The voltage decreases with rising temperature and decreasing radiation. 

  

Boundary values in defining the MPP voltages that occur in the PV system are: 

• a working point for high irradiation and low temperature to define the maximum MPP voltage, 
and 

• a working point for low irradiation (onto the tilted module surface) and maximum module 
temperature to calculate the minimum MPP voltage. 

The working points are dependent on the: 

• location of the system, 
• orientation and inclination of the modules, and the 
• type of module mount. 

PV*SOL® takes the lowest module temperature as being equal to the lowest external temperature in the 
climate data record being used. Maximum radiation is taken from the climate data record for the month 
in which this temperature occurs, for the preceding month, and for the following month, and is converted 
onto the tilted module surface. For example, with an orientation due south and a 30  inclination, the 
values for two different locations are: 

Berlin: 14 C und 858 W/m² 

Freiburg: 11 C und 957 W/m² 

To define the system’s lowest MPP voltage, the value of the irradiation during module part load 
performance is taken from the module database as the minimum irradiation. For example: 300 W/m². 

The maximum module temperature for this irradiation is defined by the maximum temperature at the 
system location plus an offset. The maximum system location temperature is read from the climate data 
record being used. The offset is dependent on the module mount and the irradiation. 

It applies that: 

Tmax,Modules = Tmax,Sys. Location + factor * Gmin / 1000. 

Factor = 20 for free-standing modules, 

Factor = 30 for rooftop mounting with ventilation space, and 

Factor = 45 for roof or façade-integrated modules without ventilation space 

This gives, for example, an offset of +9°C on the external temperature for modules with ventilation space, 
and a minimum irradiation of 300 W/m². 
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If under Options/Settings/System Check you select Set Values, you can enter temperature and 
irradiation extremes, which are then used in the system check. 

The module array’s MPP voltage is calculated for both of the working points described above, and then 
compared with the inverter’s MPP tracking range. 

A message warning of discrepancies appears if the inverter’s threshold values vary by more or less than 
10% from the modules. A value over 50% less than the lower MPP threshold is not permitted. 

Overstepping the upper MPP threshold is restricted at the next stage by the strict observation of the 
maximum no-load voltage. 

Upper Voltage Threshold Check 
The inverter’s maximum system voltage must not be exceeded on any account. Exceeding the inverter’s 
upper voltage threshold can cause irreparable damage to the inverter. 

The maximum occurring voltages should be checked very carefully. 

As a comparative value PV*SOL® defines the module array’s no-load voltage at the working point: 
minimum module temperature and maximum irradiation. This point has already been calculated for the 
MPP voltage check (see: MPP Voltage Check). 

A message that the critical voltage has been reached appears if the module array’s no-load voltage 
equals the maximum inverter voltage. 

You are able to continue with simulation, but you should take into account when planning your system, 
that exceeding the maximum inverter voltage can cause irreparable damage to the inverter. 

Exceeding the maximum voltage by 25% is not permitted. 

The following checks are made on stand-alone systems: 

Stand-Alone System Inverter AC Output Check 
For AC appliances the inverter’s nominal AC output and the appliances’ maximum output are compared to 
ensure that the inverter can deliver the maximum output for the appliances. 

Without a back-up generator, a message appears if the inverter output is less than 98% or greater than 
120% of the appliances’ maximum output. Outputs less than 33% and greater than 500% of the 
appliances’ maximum output are not accepted. 

If a back-up generator is used, this is able to cover the consumption directly, ie the back-up generator’s 
energy does not flow through the stand-alone system inverter. The upper threshold remains the same, 
but the program does not strictly set the lower threshold. 

Stand-Alone System Inverter Voltage Check 

For the AC appliances, the battery voltage is compared with the inverter voltage. Both components are 
loaded from the database and have to be checked against the system voltage. 

Battery Voltage Check 
If your system has direct battery connection, the battery voltage sets the modules’ working point. The 
battery voltage is dependent on the charge condition. PV*SOL® works with a characteristic curve for the 
(averaged) voltage. 

These benchmark figures are compared with two working points for the modules’ MPP voltage, ie the 
MPP voltage at 500 W/m² and 25°C, and at 1000 W/m² and 25 C (STC) 
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A message appears if the minimum battery voltage is less than 60% and the maximum battery voltage is 
larger than the corresponding MPP voltage. 

Simulation is blocked if the minimum battery voltage is less than 40% and the maximum greater than 
110% of the corresponding MPP voltage. 

MPP Tracker Output Check 
If an MPP tracker is used, a check is required to see if the MPP tracker’s output corresponds to the PV 
output. If the figure is exceeded the PV energy produced will be reduced, if the figure is not reached the 
MPP tracker works at a poor efficiency rate. 

A message appears if the MPP tracker’s output is less than 90% and more than 120% of the PV output. 
MPP tracker outputs less than 33% and more than 500% of the PV output are not accepted. 

MPP Voltage Check 
The MPP tracker’s MPP tracking range is compared with the module array’s MPP voltages. The voltage 
decreases with increasing temperature and decreasing radiation. The definition of the working points is 
as described in the grid connected system check. 

For both of these working points the module array’s MPP voltage is calculated and compared with the 
MPP tracker’s MPP tracking range. 

A message warning of discrepancies appears if the MPP tracker’s threshold values vary by more or less 
than 10% from the modules. Not reaching the lower MPP threshold of around 50% or exceeding the upper 
MPP threshold of around 25% is not permitted. 

Cabling checks are made on both types of systems, and on each sub-array. 

DC Cabling Check 
The flow of current through the cabling under standard test conditions (STC) is defined by the module 
current flow under STC and the number of parallel-connected modules in an array. This should not be 
more than the permitted electrical capacity of the cabling. 

In the program, the maximum capacity for group 3 insulated copper wiring is based on the Federation of 
German Electricians’ regulations. Relative cabling losses are calculated from the cabling resistance, 
electricity and voltage under standard test conditions. 

Cabling losses of above 20% are not accepted and PV*SOL® produces a message when these are above 
5%. 

12.2.2 Database Monitoring System 
When a mismatch is uncovered by the database monitoring system, a corresponding message appears 
on screen. For example: 

1 In PV Array 1 no module file has been selected from the database! Do you want to select a PV module? 
If so click on the PV Module button. 

2 The database file for the module 
data in PV Array 1 no longer exists! 
Do you want to save the data to a new file? 

3 The database file 
c:\pvsol\biblio\module\mei76.mod 
has been changed! 
Load file data into your project? 
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Checks 1 and 2 take place when the corresponding dialog (Tariffs, Technical Data, Appliances) is closed 
with ”OK”. These messages are for information and can be closed by clicking on ”No”. 

Check 3 takes place before simulation and, for modules and inverters, additionally when the ”Technical 
Data” dialog is opened. 

It is best to answer ”Yes” to the question ”Load file data into your project?” (except in the instance when 
you open an old project and want to simulate the old conditions), or to select ”Accept All” beforehand. 
(see Message: ... Database File...). 

12.2.3 Message: ... Database file ... 
The database file has been changed! Load file data into your project? 

Components from the corresponding Database are loaded from the dialogs: Tariffs, Polutant mix, 
Technical Data and the load pattern in the Electrical Appliances dialog. The program loads the 
corresponding values and notes the file name. 

If you change the database files that have been loaded or saved in a project, the program informs you 
before simulation, that you have made changes to the database file without loading the new values into 
the project. 

If you answer YES the project data is updated with the corresponding amended database data; if you 
answer NO the original values are retained. 

Because all the database files that are loaded into a project are checked before simulation, you can click 
on Accept All so that you only have to answer the question once. 

Cancel ends not only the data checks, but also the simulation. 

This message appears for modules and inverters, and also on opening the technical data dialog. 

No data checks for “To Grid Tariffs”! 
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13 Language Menu 
PV*SOL® currently offers a selection of the following languages: English, French, German, Italian, 
Spanish. 
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14 Help Menu 
You can also access this menu command by use of the F1 key from anywhere within the program. 

Via the Internet Service you are able to download a PV*SOL® Order Form from the internet, or find out 
more about Valentin Software. 

The menu command Info provides details on the program such as the PV*SOL® version number. 

Changing the PV*SOL® version you are using is possible with the Change Registration command. 

For example, this is necessary if you want to convert the Time-Limited Version to the Full Version, or the 
Grid Connected Only Version to the Version for both Grid Connected and Stand-Alone Systems. 

From the Change Registration command, when prompted, place the new licence disk in the drive. This 
will release the new version for immediate use. 
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15 Glossary 
Array – see PV Array. 
Back-up Generator – Direct Energy Use 

If a back-up generator is specified in the system configuration, the energy generated by the back-up 
generator and the energy used directly by the appliances is identified. With direct current 
appliances, the alternating current is converted to direct current by the battery charger. 

Back-up Generator - Energy 
The energy generated by the back-up generator includes direct energy consumption and the energy 
used to charge the battery. 

Back-up Generator – Fuel Consumption 
If a back-up generator is used, the annual fuel requirement needs to be specified. The fuel 
consumption is calculated from the energy generated by the back-up generator and the specific fuel 
requirement entered. 

Battery - Charge 
The total energy going into the battery (or the batteries) is shown. If the system is simulated without 
a back-up generator, this corresponds to the solar energy charge. 

Battery –Charge, Solar 
For systems with a back-up generator, the portion of the charge that comes from solar energy is 
given separately. The difference from the total charge comes from the back-up generator’s portion. 

Battery – Charge Condition 
The battery’s charge condition at the start of simulation can be defined in the system configuration 
(default = 30%) 

Battery – Content, Back-up Generator (After Simulation) 
This value appears only when a back-up generator is used. It describes the proportion of energy 
produced by the back-up generator that is available in the battery at the end of the simulation 
period. 

Battery – Content, Solar (After Simulation) 
The proportion of solar energy available in the battery at the end of the simulation period is given. 

Battery - Discharge 
The total energy from the battery (or the batteries) is shown. If the system is simulated without a 
back-up generator, this corresponds to the discharge of solar energy. 

Battery – Discharge, Solar 
For systems with a back-up generator, the proportion of discharge that is based on solar energy is 
given separately. The difference from the total discharge comes from the back-up generator’s 
portion. 

Battery - Losses 
Battery losses come from the battery efficiencies during charge and discharge, and self-discharge. 

Battery - Performance Ratio 
The battery’s performance ratio is the relationship between discharge and charge. 

Charge Condition at Simulation Start/End 
The battery’s charge condition at the start of simulation (defined in the system configuration) and the 
calculated charge condition at the end of simulation is shown. 
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Consumption - Requirement 
The requirement is the sum of the annual energy requirement of all defined Appliances. 

If no appliances have been defined, this value is not given. You are also able to define appliances if 
the ”Full Supply” to grid concept has been selected. 

Consumption – Covered by Solar Energy 
The consumption covered by solar energy is made up of direct energy use and the solar portion of the 
battery charge. 

Consumption – Not Covered 
The consumption requirement that cannot be covered by the system is shown as the amount of 
energy required that cannot be provided either by the PV array or by the battery. 

Energy Converter 
This dimension is only shown if MPP tracking is going to be used. The losses that occur when using 
an MPP tracker are subtracted from the generated energy. 

Energy Requirement - Covered by PV Generator 
This dimension is only given when the ”Own Use” concept is selected. It is the energy generated by 
the solar system that is used to cover the energy requirement of the appliances. 

External Temperature 
The external temperature is a specification taken from the climate data files. It is required to define 
the module temperature, as the module efficiency is dependent on the temperature (see PV Module). 

Generated Solar Energy (Alternating Current Side) 
The generated solar energy (AC side) is the energy after conversion of the PV direct current into 
alternating current, which can either be fed into the grid or used to cover the load requirement. The 
energy used by the inverter itself is not taken into account. 

Generated Solar Energy (Direct Current Side) 
When designing a PV system, the energy that is produced by the PV modules is also of interest, ie the 
energy flow before entry into inverter. 

Grid, Electricity From 
If all the energy produced by the PV system is fed into the grid, the total load requirement and the 
inverter’s own consumption will have to be covered by electricity drawn from the grid. If the ”Own 
Use” concept is selected, the energy drawn from the grid is reduced by the proportion of PV 
generated energy that is used to cover the load requirement. 

Grid, Electricity To 
If the ”Full Supply” to grid concept is selected (see Tariffs), all solar energy generated is fed into the 
grid and this dimension is not given. If the ”Own Use” concept is selected, only the proportion of 
energy that is not used by the appliances is exported to the grid. 

Inverter Efficiency 
The inverter efficiency is the energy generated on the alternating current side in relation to the 
energy fed into the direct current side. 

The efficiency is made up of the Inverter Characteristic Curve, the MPP adjustment efficiencies (see 
Inverter Database) and the inverter’s own consumption. 

A very poor inverter efficiency (in comparison to maximum efficiency) is above all possible if the 
inverter is oversized or because its maximum nominal output limits the PV power output. 
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Irradiation onto Tilted Array Surface 
The irradiation onto the tilted Array surface is the energy (after subtraction of shade) on the PV 
surface that is available for conversion. A proportion of this energy is lost through reflection on the 
module’s surface. 

Module Temperature 
There are two different Temperature Models in the program. Module temperature definition is 
dependent on the climate data, module specific parameters and the type of mount. The module 
temperature for each array is given on each array worksheet. 

Own Consumption - PV System 
The PV system’s own consumption comes from the energy used by the inverter, when no PV energy is 
being produced. During the day, the inverter draws on the grid for its stand-by consumption. At 
night, if the inverter is not switched off completely, it also draws energy for night consumption. Both 
dimensions are entered in the characteristics for the Inverter. 

Performance Ratio 
The performance ratio is a measurement of the energy losses within the system that occur in 
comparison with the system’s nominal output. The nominal output is calculated from the irradiation 
onto the tilted PV surface multiplied by the module efficiency under standard test conditions (25 C, 
1000W/m²). 

PV Array/Sub-Array 
System > Technical Data > PV Array/ Array i 

A PV array/sub-array is a PV surface unit made up of the same types of module mounted together and 
set at the same angle and orientation. If you have a number of inverters connected to an array, these 
also have to be all the same type. 

PV Array – Direct Energy Use 
Direct energy use means the energy that flows direct (without being stored before use) to the 
appliances. With alternating current appliances, however, the energy will have to be converted to AC 
by the stand-alone system inverter, before it can be used to cover electricity consumption. 

PV Array – Energy Surplus 
An energy surplus occurs if the solar energy available is not required by the appliances and the 
battery is charged. 

PV Array – Generated Energy 
The generated energy is the energy exiting the PV generator. Losses through MPP tracking are not 
accounted for. These dimensions also include any PV array surplus that may occur. 

PV Array - Irradiation 
The irradiation onto the tilted PV array surface is the solar energy that remains available after 
subtraction of shade. A proportion of this energy is lost through module surface reflection. 

PV Array - Efficiency 
The PV efficiency is the DC energy produced in relation to the total energy irradiated onto the array 
surface. Here the inverter’s efficiency and the cabling losses are not taken into account, as they are 
during the system efficiency calculation. 

The array efficiency takes the following into account: 

• the reflection losses at the module surface, 
• the PV module’s efficiency, ie the characteristic curve for the PV module and the temperature 

coefficient for PV output (see PV Module database), and 
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• the array’s Additional Losses. 

PV Array - Radiation 
The program uses a radiation processor to convert horizontal radiation into radiation onto the tilted 
surface using the following dimensions: the degree of latitude, the angle of inclination, the azimuth 
and the albedo. 

Radiation Minus Reflection 
Part of the radiation onto the PV surface is lost due to reflection losses on the module surface. The 
direct radiation is reduced by the module incident angle modifier (see also: PV Module) 

Radiation onto the Horizontal 
The horizontal radiation is taken from the Climate Data Files. 

Radiation Without Shade 
If the array is shaded for a period, the radiation that would fall onto the tilted PV surface if the 
surface was not shaded is identified. 

Solar Coverage Proportion (Grid Connected) 
The proportion of solar coverage is the generated energy (after subtraction of the inverter’s own 
consumption) in relation to the load requirement. It is only of interest for the ”Own Use” concept (see 
Tariffs) and is only given if an electrical appliance is defined. The solar coverage proportion does not 
express how much of the generated energy can be used in direct load coverage. 

Solar Coverage Proportion (Stand-Alone) 
The proportion of solar coverage is the relationship of the consumption covered by solar energy and 
the energy requirement. The consumption covered by solar energy comes from direct energy use and 
the solar portion of the battery charge. 

Specific Annual Yield 
The specific annual yield is an evaluation dimension that gives the system’s annual yield 
standardised to the installed output. In other words, the specific annual yield corresponds to the 
system’s peak load operating hours. 

Another well known evaluation dimension is calculated from the specific annual yield: the final yield. 
The final yield is the specific annual yield divided by 365 days. 

System Efficiency 
The system efficiency is the quotient from the usable solar energy from the PV system and the total 
energy irradiated onto the generator surface. It is made up of the PV array efficiency, the inverter 
efficiency and the cabling losses. 

Wind Speed at a Height of 10m 
The wind speed is accounted for when defining the module temperature in the dynamic Temperature 
model. In the climate data files provided the wind speed is measured at a height of 10 metres. 
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